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1 INTRODUCTION

This chapter introduces the company, QlikTech, and explains the differences 
between the QlikView products. It outlines the basic capabilities of 
QlikView Desktop and the underlying contents of a QlikView file. It also 
lays out the format and structure of the rest of the manual, and guides you 
through the installation of QlikView Desktop and the course materials on 
your computer.

Who is QlikTech?
QlikTech was founded in Lund, Sweden in 1993. Today, research and devel-
opment continue to be focused in Lund. Our International Headquarters are 
in Radnor, Pennsylvania. QlikTech has offices and partners around the 
world and is experiencing rapid and sustained growth.

Information is the lifeblood of any organization. It is the foundation of 
knowledge, and knowledge is the basis for appropriate action. This can be a 
distinct competitive advantage. QlikTech delivers fast, powerful and afford-
able data analysis and reporting solutions, giving users clear insight and 
enhanced decision-making capabilities across the enterprise. 

How does this happen? Through innovative technologies and unmatched 
customer service.

What is QlikView?
QlikView is a revolutionary platform that simplifies analysis for everyone. It 
is user-friendly and provides superfast in-memory analysis capabilities by 
dynamically integrating and presenting data from multiple data sources, or a 
single Excel or text file. 

QlikView provides analysis and reporting that is
• Easy to use
• Broadly distributed
• Flexible
• Insightful

QlikView files can be deployed to users on corporate networks or through 
sophisticated web-based portals and can be viewed in many different file 
types. Some of the more common analysis clients for QlikView files include 

Objectives
• Learn about QlikTech
• Define the  QlikView product family
• Appreciate how and why QlikView is different
5
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Java Objects, Internet Explorer plug-in, AJAX (Asynchronous JavaScript 
and XML) Zero-Footprint and Windows-based clients. QlikView analysis 
files can also be e-mailed, just like a Word or Excel document, and can be 
secured in many different ways. 

QlikView files are created using QlikView Desktop and are deployed and 
distributed using QlikView Server and QlikView Publisher. Users access the 
files with QlikView in various client types, listed above.

The QlikView Products

QlikView products include:

Desktop — to build a full-function QlikView application

Clients— for the End User

Server — for Deployment of QlikView applications

Publisher — for Distribution of QlikView applications

QlikView Desktop 
This course, QlikView Designer I and the subsequent class, Designer II focus 
on the user interface designer’s toolkit for creating compelling QlikView lay-
outs and design. QlikView Desktop is also the subject of a different series of 
classes, Developer I and Developer II with the focus on extracting, modeling 
and loading data to be used in the constuction of efective analytical tools.

QlikView manages information like the human brain works. Just like the 
human brain, QlikView makes associative connections in the information 
being processed. You – not the database – decide which questions to ask. 
Just click on the item you want to know more about. Conventional informa-
tion search systems often require a top-down approach, while QlikView 
allows you to get started with any piece of data regardless of its location in 
the data structure. 

The retrieval of data in conventional systems is often a complex task requir-
ing extensive knowledge of the structure of the databases and of the syntax 
of the query language. The user is frequently limited to predefined search 
routines. QlikView revolutionizes this by making it possible to select freely 
from data displayed on the screen with a click of the mouse. 

QlikView is flexible. You are the one to decide how the program is to be 
used. QlikView helps you acquire a unified and coherent overview of the 
data in different databases and/or datasources. QlikView can be used with 
virtually any database and/or datasource. 

With QlikView you can
• create a flexible end user interface to an information warehouse
6



QlikView Designer I | INTRODUCTION
• get snapshots of data relations
• make presentations based on your data
• create dynamic graphical charts and tables
• perform statistical analysis
• link descriptions and multimedia to your data
• build your own expert systems
• create new tables and merge information from several sources
• build your own business intelligence system

Some examples of QlikView applications being used today are financial sys-
tems, sales analysis, human resources administration, market analysis, cus-
tomer support, project administration, production control, stock inventories 
and purchasing. You can even mix the different applications to gain entirely 
new information overviews.

A QlikView document is not a database in itself, although each Qlikview file 
contains its own data repository that is updated every time the script is run. 
The contents of a typical QlikView document are shown, below:

We will be working with existing QlikView (.qvw) files in this course and 
focusing almost exclusively on the layout (data display) of QlikView files. 

The next section will guide you through the process of installing QlikView 
Desktop and the course materials on your computer.

Figure 1.  The structure of a QlikView file and its relation to external data 
sources.
7



QlikView Designer | INTRODUCTION
Course Logistics

Preparing for Class

Installing the Course Materials

The course materials will self-extract from the file into the default directory
C:\QlikViewTraining\DesignerI\ 

Make a Windows shortcut to this folder and place it on your desktop.

Also make a Windows shortcut to the documentation folder (see below) and 
place it on your desktop.

C:\Program Files\QlikView\Documentation

Notes

Program versions

This course material was created using the English version of QlikView 9.00  
running on WindowsXP. Thus, if other operating systems or languages are 
used, minor differences may be noted in the visual appearance of windows 
and dialog boxes.

 Text formats of this material

Exercises and actions to be completed by you, the student, will be set-off 
with a logo, as you see, below:

Exercise/Do:
This is a sample of instructions you would see to complete an exercise con-
taining a sequence of steps.

1 Click on the Start button
2 Locate the QlikView icon
3 Click on the QlikView icon to launch the program

All commands, as well as all names of menus, dialogs and buttons are in the 
following font style:   File - Open

All names of list boxes, graphs and specific data in list boxes, etc. are in the 
following font style:   Country

All file names are in the following font style:   QlikViewCourse.qvw

Tips and Notes are outlined in a highlighted box, as you see below: 

This sample sentence is used to illustrate important points in the text, tips 
and notes to consider as you complete the course materials
8
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2 LAYOUT AND DESIGN BEST PRACTICES

Layout and design are crucial to a successful QlikView application. This 
chapter will introduce some simple concepts that QlikView developers 
should find useful when making basic design decisions.1 

QlikView is not only a developer tool for accessing data, it also provides an 
elegant designer’s toolkit for building an appropriate user interface.

We will cover:
• Natural Human Behavior
• Recommendations
• Guidelines for Basic Choices for Charts and Objects in QlikView
• Introduction to the DAR Concept (Dashboard - Analysis - Reports)

Let’s get started by looking at our behavior as human beings, how we inter-
pret information, and the effect the presentation of information has on our 
perceptions.

Natural Human Behavior
In this section of the course, we will look at how people see things. In partic-
ular, we will examine the impact of specific considerations on the perception 
and, therefore, the success of our designs. These considerations include:
• Visual Perception
• Positioning
• Colors
• Sizes
• Logos and Images
• Fonts
• Borders

Objectives
• Introduce the concept of natural human behavior (how we perceive 

and process information)
• Understand fundamental user interface layout and design best prac-

tices
• Apply the Dashboard-Analysis-Reports (DAR)  concept

1. Some of the information in this chapter comes from Information Dash-
board Design: The Effective Visual Communication of Data, by Stephen
Few. Sebastopol, California: O’Reilly Media, Inc., 2006.
9
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By examining each of these areas, we will be able to make judgements about 
how we build our QlikView applications, the objects we choose, where we 
place them on the screen, the colors and fonts that go into the finished prod-
uct.

Visual Perception

Here is a direct quotation from an expert in information design, Collin 
Ware, from his book, Information Visualization: Perception for Design, Sec-
ond Edition (San Francisco: Morgan Kauffman, 2004), xxi.

[W]hen data is presented in certain ways, the patterns can be readily per-
ceived. If we can understand how perception works, our knowledge can 
be translated into rules for displaying information. Following percep-
tion-based rules, we can present our data in such a way that the impor-
tant and informative patterns stand out. If we disobey the rules, our data 
will be incomprehensible or misleading.

How we “see” determines how we “perceive.” Although vision is the con-
duit, perception comes from our brains. It is there that sense is made of what 
we see. Perception, in turn, is limited by what we focus on, and only a frac-
tion of that makes it into our consciousness. An even tinier amount of what 
grabs our conscious attention, our focal point, gets stored in our memories.

From the QlikView perspective, here is a top-down view of the relationship 
between data and, ultimately, the end-user’s ability to make sense of it.

This is important, because our eyes do not register everything that is visible, 
but, rather, only what they perceive, and this, again, is controlled by the 
brain. Since only a small part of what we “see” becomes our focus, and only 
a fraction of that grabs our attention or becomes part of our conscious 

Figure 1.  Putting the pieces together to understand the significance of visual 
perception with QlikView.
10
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thought, and, finally, even less gets stored for future use, our designs of 
human interfaces, in this case, our QlikView pages, are crucially important.

Obviously, bad data, no matter how well presented, leads to error. Without 
good design, though, even the best data will be impenetrable or, perhaps 
even worse, specious.

Before moving further into layout and design best practices, let us take a 
moment to understand how our memories work.

Limits of Short Term Memory

Human beings have three types of memory. They are:
• Iconic
• Short-term
• Long-term

Iconic memory is based upon something called pre-attentive processing. 
Certain attributes of what we see are recognized during pre-attentive pro-
cessing. Circles and squares, bolded items set-off from unbolded items, sets 
of objects grouped together: these are examples of things that stand out for 
pre-attentive processing.

Preattentive processing is extremely fast. We can learn some basic design 
rules to help us build our QlikView pages to take advantage of preattentive 
processing.

The following two figures demonstrate the difference between attentive pro-
cessing, which is linear and slow, versus preattentive processing, which is 
subconscious and lightning fast.

More attention will be paid to preattentive processing design principles in 
the subsequent sections of this chapter.

Short-term memory is where you store information while you are processing 
it. Typically, this means 3-9 chunks of visual information at a time. When 

Figure 2.  An example of attentive versus preattentive processing.
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your short term memory gets full, pieces are either moved to long-term 
memory (see below) or forgotten!

We can extrapolate some basic design theories from this. 

Long-term memory is fundamentally different from iconic and short-term 
memory. It is a memory that lasts longer, and is stored differently. Within the 
limits of human endeavor, long term memories can be understood best as a 
means of keeping, organizing and remembering information/events over 
time. Some long-term memories last weeks, others years or even decades, 
sometimes for an entire lifetime.

Gestalt Principles of Visual Perception

Gestalt is a German word for patterns. The Gestalt School of Psychology is 
based on the premise that human beings organize what they see in specific, 
observable ways in order to comprehend it. The Gestalt principles of percep-
tion encompass visual characteristics that cause humans to group things 
together. 

From an understanding of these basic principles, we can create our 
QlikView pages to intentionally connect certain data, to separate other data, 
and to make data stand out from the rest.

These characteristics include:
• Proximity
• Closure
• Similarity
• Continuity
• Enclosure
• Connection

Examples of these Gestalt principles of visual perception follow, below.

Tip: You should never fragment information that belongs together. 
Scrolling is out. Keep everything relevant within human eyespan on a sin-
gle screen, ensuring the exchange of information in and out of short-term 
memory at lightning speed.
12
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Proximity: White space separates the 3 groups that we automatically see 
(instead of 10 dots).

Closure: We naturally perceive this object as a complete oval rather than 
three curved lines. 

Note, too that we can make use of this to group object into visual regions 
without the use of complete borders and lines. 

Our brains do the work for us. This is important as every object (every line, 
every ink pixel) needs to be processed. 

To maximize the rate of information per screen, we take away everything 
that is not needed, everything that does not carry information. Taking away 
unnecessary content avoids clutter.
13
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Similarity: Similarity works very effectively to identify different data sets in a 
graph. Only one legend is required in the example, above.

Continuity: Why we see this as a single wavy line, not a series of dashed 
lines.
14
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Designers face two challenges when building effective interfaces for human 
visual perception.

The first challenge is to highlight the most important data so that it is prom-
inently displayed. 

The second challenge is to give meaning to large amounts of disparate data 
and information by proper arrangement in support of efficient perception.

Neither of these are easy tasks. The remaining sections of this chapter give 
specific advice and tools to help prepare you to build good QlikView pages 
to meet these two challenges.

Positioning

Positioning, as you would expect, is all about the placement of objects on 
the page. By nature, human beings are drawn to look at the page in a certain 

Enclosure: Please note that the arrangement of the two sets of circles is iden-
tical. It does not take much to direct our perception to group the elements in 
the desired way. (Thin line, light shade of gray)

Connection: The perception of grouping produced by connection is stronger 
than that produced by proximity or similarity. But it is weaker than that 
produced by enclosing.
15
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way. Knowing that, it makes sense to design your QlikView pages to take 
advantage of our natural tendencies to be sure you get your point across.

In general, your eyes will be drawn to the top left corner of the page first, as 
in the figure, below.

It is logical to assume, then, that the top left corner of the page is the most 
valuable location, since it will always be viewed first.

In some situations, more complex grids require your mind to do a little more 
work, such as in the figure, below.

Figure 3.  Location grid showing the order of attention on a page, by quad-
rant
16
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The image, above, is a good example of an overly complex view. Simplicity 
is a good rule to remember when designing. Do not place too many objects 
in one view. 

Colors

Some colors take a hold of us and shake us. Fully saturated, bright colors do 
this. Colors that are common in nature, such as soft grays, browns, oranges, 
greens and blues are soothing, calm and do not scream for attention. These 
should be our standard colors.

Proper use of colors in your design means that the QlikView users will look 
where you want them to look. Colors are a very powerful “eye navigator.” 

Figure 4.  Determining that “Miami” is the organizing principle of this view means 
work, but, once understood, the pictures can be viewed from left to right and top to 
bottom.

Tip: Limit number of significant objects on a page to four, one for each 
quadrant.
17
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Make sure you indicate the right way, by signaling – with colors – where the 
important information resides.

Reserve the bright fully saturated colors for special cases. An example of the 
relationship between Emphasis colors and Standard colors follows.

Other issues with color choices include the number of different colors used, 
color persistency and color choice.

Figure 5.  Comparison between Emphasis and Standard color schemes
18



QlikView Designer I | LAYOUT AND DESIGN BEST PRACTICES
Figure 6.  Too many colors: it is impossible to tell which bubble is more 
important.

Figure 7.  Color persistency problem: the bubbles on the right do not use the 
same colors to represent the elements in the bubbles on the left.
19
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Color must be used correctly, with an understanding of the background, 
frame of reference and objective in delivering information to the user.

Sizes

Even without colors, size matters. We have already seen that pages are typi-
cally broken into four quadrants of equal proportion. Within objects them-
selves, size can play an important role in helping your users focus on the 
most meaningful information, the things you, as a designer, want to empha-
size.

Figure 8.  Color choices: your preference for a vendor might be revealed by 
your color choices.

Figure 9.  Example showing the significance of size. Even without any col-
ors, your attention is drawn to the largest box.
20
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Logos and Images

Logos and images are tempting. They can be nice to look at and make your 
interface look pretty. Even so, you should avoid them, unless they are 
required for marketing or corporate standards.

Tip: When placing objects, give good size, space and location to the most 
important KPIs. Alternatively, you can equalize chart sizes to force the 
same amount of attention.

Figure 10.  An example of images and logos improperly placed, using the most valu-
able space on the page; not good design.
21



QlikView Designer I | LAYOUT AND DESIGN BEST PRACTICES
The predominant danger with logos and images is their tendency to become 
the point of emphasis on the page, when, in fact, it is the data that should be 
emphasized.

If you must use logos or images, try to keep them small, unassuming and out 
of the way.

Fonts

Fonts are another temptation to display errant creativity. The purpose of 
good design is to convey meaningful information as quickly and simply as 
possible. Avoid the urge to embellish with special fonts. In fact, choose the 
simplest font possible and be consistent with it. If you need to use one other 
font for headings or titles, so be it.

Figure 11.  An example of inappropriate logo usage, too prominent and 
using valuable location on the page.
22



QlikView Designer I | LAYOUT AND DESIGN BEST PRACTICES
Remember, your goal is to give your user the font that can be read the fast-
est, and with the least amount of eye strain.

Borders

Once again, the dominating design principle is to emphasize the data. In 
some circumstances, borders can help with this. In others, the absence of 
borders may be preferred. 

Figure 12.  Legible versus illegible fonts.

Figure 13.  Borders that distract.
23
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Figure 14.  An example where white space is used (top half) in lieu of a bor-
der. In the bottom half, light borders are appropriate in place of the missing 
white space.

Tip: Any border which draws attention to itself, rather than the presenta-
tion of data, is inappropriate
24
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Recommendations

Edward Tufte’s Five Principles

We have spent some time going over Natural Human Behavior and all that it 
infers about design best practices. Much of the material we have covered so 
far has been drawn from the writings and designs of Stephen Few.

In addition, we should touch upon the over-arching principles promulgated 
by Edward Tufte, probably the leading expert on information design.

He summarizes the challenge faced by all designers who must figure out the 
means to represent a world of myriad dimensionality within the context of 
relatively limited displays. 

His framework for doing this can be summarized in the following five prin-
ciples of information design:

1 Quantitative thinking comes down to one question: Compared to what?
2 Try very hard to show cause and effect.
3 Don't break up evidence by accidents of means of production.
4 The world is multi variant, so the display should be highly-dimensional.
5 The presentation stands and falls on the quality, relevance, and integrity 

of the content. Content, like location in real estate, is king.

Advice

If we were to list out all the best design guidelines, we could easily fill a few 
dozen pages or more. The following are some of the more obvious and 
important ones.

1 The data must be of high quality.
2 Include comparisons.

Comparisons are a very effective way to show relationships.
25
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3 Content that is related should be linked.
4 Simplicity always trumps an excess of detail.
5 Any chart is more readable with solid colors, not gradients.
6 In many cases, a simple bar chart is superior to a radar chart or a pie 

chart.
7 Pay attention to scale.

8 Avoid 3-dimensional anything.
9 Single, neutral colors are easier on the eyes.
10 If you use multi-colors, be sure they are used consistently. 
11 Remove redundancy, within reason.
12 Users should never scroll to find something important.
13 Keep the macro view if it is meaningful, then break it into smaller 

chunks.
14 Revise and edit; prune, review, revise and edit some more!

Chart and Object Choices in QlikView
All of the major QlikView objects and chart types are covered in either this 
course, or in the Designer II course.

For now, it is important to address design considerations when choosing 
QlikView objects for specific needs. This section of Layout and Design Best 
Practices is meant to serve as a reference guide for picking the right object or 
chart to fit the type of analysis to be done.

We will cover the following QlikView object types:

Charts —
• Bar 
• Line
• Combo

Q: Which company is doing better? A: Neither. They are identical. The scales, high-
lighted in gray, are different.
26
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• Radar
• Gauge
• Scatter
• Grid
• Pie
• Funnel
• Block
• Straight Table Chart
• Pivot Table Chart

For each type of chart we will list the type of analysis used and some sample 
metrics, beginning with Bar charts.

Bar Charts

Figure 15.  Selection of Chart Types in QlikView, including pivot and 
straight tables

Best: Comparisons of similar measurements

Examples:
• Actual vs. Budget — Money to Money, Quantity to Quantity
• Time — Time
• Top N — Categorized Values (sales reps, customers etc)
Avoid: Comparisons with different units ($ and Qty)
27
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Line Chart

Combo Chart

Best: Measurement to follow its movements or comparisons among 
items

Examples: 
• Performance Trends — Amount of movement over time
• Two Dimension Comparisons — Annual COmparisons over 

Months

Best: Comparisons for multi-measurements

Examples:
• Two measurements — Currency Amount and Quantity or Amount 

and Percentage
• Two Axis — Different measurements on left and right axis
• Two or More Axis — Split axis horizontally
28
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Radar Chart

Gauge Chart

Best: Comparisons of high-level groups

Examples:
• One or Two Measurements — Sales and Profit

Avoid: a dimension with many values

Best: Ratio of measurements

Examples:
• Percentages — Margin, Quota Achieved, Year-tot-Date vs. Last 

YTD

Avoid: Actual amounts
29
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Scatter Chart

Grid Chart

Best: Measurements act as dimensions (3D chart)

Examples:
• 3D Measurement Chart — Amounts, Quantity and Number of Cus-

tomers
• Map Chart — See sales on a geographical map

Best: 2 or 3 dimensions with a measurement

Examples:
• Multi-cross dimensional measurements 
• Amounts over region and product, over time
30
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Pie Chart

Funnel Chart

Best: Visual distribution measurements

Examples:
• What contributes how, to the whole — Regional Sales
• Yes / No analysis

Best: Dimension that contains an expiration timeline

Examples:
• How much is the most aging element?
• Sales Opportunities
• Product Inventory by Expirations
31
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Block Chart

Straight Table

Best: Distribution measurements within multi-dimensions

Examples:
• What contributes how to the whole and within each segments 
• Sales contribution per country

Best: One dimension with multiple measurements

Examples:
• KPI Overview — Cycle group dimension with Sales, Qty, Margin
• Sort in any columns (No grouping)
32
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Pivot Table

Best: Multi-dimensions with one or more measurements

Examples:
• Grouping of dimensions — Product sales by item
• Dimension across the table — Annual sales by months
• — Variance calculation using before( )

Limitations: 
• No repetition of the same values (grouped)
• No end-user sort by double-click
33
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Trellis Chart

Sparklines

Best: Multi-dimensions with one or more measurements where the first 
dimension of the chart is used as an iteration for producing an array of 
charts. Accessed via a button on the Dimensions tab of the chart object 
(New in QlikView 9.00)

Examples:
• Comparisons — Product sales and margin
• Dimensionsal Iteration — Annual sales YTY by region

Best: New in version 9.00, these mini charts display the result of an 
expression as a small chart in the cell of a QlikView table. 

Examples:
• Snapshots — Trend analysis
• Comparisons — Summary dashboards
34
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Introduction to Dashboard • Analysis • Reports – DAR
Different users have different needs. This section concerns providing tools 
and methods for different user communities within an organization. Every 
QlikView application can be structured to fulfill user’s needs for three types 
of tools
• Dashboards for quick access to critical metrics
• Analysis tools for digging deeper, and
• Reports for a structured, predictable presentation of key metrics and 

information

This section considers these three areas and how they are implemented with 
QlikView.

Dashboards

Dashboards are designed to provide the quick overview that decision mak-
ers need to oversee the well-being of their operational responsibilities, as 
well as giving them the chance to see and act on opportunities. They might 
focus on high-level measures of performance and forecasts, or more mun-
dane but no less important metrics and indicators. 

Included might be measures of
• Year-to-Date versus Last-Year-to-Date Sales, Profits, Production, Office 

Visits, etc.
• Financial Indicators
• Sales office comparisons
• Profitability

Figure 16.  Example of a financial dashboard page in QlikView.
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Analysis

Analysis is the broader work that comes from guidance obtained from the 
dashboard. It might take a particular metric from the dashboard, Revenue, 
for example, and expand it out into tools for additional understanding. This 
might include
• Key Performance Indicators (KPIs)
• 80/20 Rules
• Actual, Budget and Forecast 
• Sales data by product segments

Reports

Traditionally, reports are information retrieved from a table or query in a 
preformatted, structured way. Examples of financial reports include:
• Balance Sheet
• Profit & Loss Statement
• Invoice Details
• Overdue Accounts Receivables

Figure 17.  Example of a financial analysis page in QlikView, showing KPIs
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DAR Samples

QlikView offers many sample files for designing QlikView applications. 
These sample files are installed with QlikView Desktop.

Conclusion • User Friendly Design
Obviously, user friendly design focuses on the user. Thus, doing proper dis-
covery with your business client to determine critical success factors is essen-
tial to your success as a QlikView layout designer. The key to success is not 
only understanding the information your users require, but truly represent-
ing exactly how they will use it as best you can.

Once you have gotten that far, you need to remember to pick an approach 
and stick to it. Simplicity and consistency are essential.

The following considerations can help your design:
• Easy to find what you are looking for: organize the QlikView applica-

tion in support of its function. Resist the temptation to add objects 
because you can, because they are cool (this can be difficult to resist!)

• Repeated objects (Clear buttons, current selections boxes, statistics 
boxes, navigation) at the same position in every sheet

• Clean layout in charts. Less is often more.
• Hierarchy dimensions placed in order
• Color choices for color-blind

Figure 18.  Example of a financial report page in QlikView, showing a balance 
sheet.
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Remember, too, that it is very easy to change things in QlikView, so should 
you encounter obstacles, it is usually better to build something even if you 
do not follow all the rules to do it, and fix it later.

If you are interested in design and information resources, please look at the 
recommendations in the Suggested Reading section.

Remember, too, to access the QlikView Download examples link and the 
Learning Center for additional examples and downloads. Once again, these 
are available on the Start Page when you launch QlikView, as below.
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3 USING QLIKVIEW DESKTOP

This chapter introduces QlikView Desktop for layout designers and shows 
you how to launch the software on your computer. You will be introduced 
to key design concepts in QlikView and will learn the basics of QlikView 
navigation. You will also receive an overview of the different menus and 
toolbars. For complete coverage of the QlikView menus and toolbars, you 
can refer to both the QlikView Reference Manual and the Online Help.

Starting QlikView
QlikView Desktop is a Windows application. Although you can make 
changes to your layout and design using QlikView clients, this course 
focuses on the QlikView Desktop. To start QlikView Desktop, click on it 
from your Windows Start Menu or create a shortcut to place on your Win-
dows Desktop or Taskbar.

1 Start QlikView. When the program has loaded, click on the Getting 
Started tab to display the Examples area, if it is not already visible.

Objectives
• Prepare your training environment 
• Navigate in QlikView
• Explore QlikView menus and toolbars

Note: If you did the “Complete” installation of QlikView and followed 
the default settings, the QlikView Reference Manual PDF file is located 
in:

C:\Program Files\QlikView\Documentation\Reference Manual.pdf 

The Online Help is available from the Help menu.

Figure 1.  Accessing QlikView’s Online Help
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The Getting Started tab contains information and links that can help you 
explore QlikView. This includes direct links to selected demo examples, a 
link to the QlikView demo example folder on your local computer and links 
to selected resources at www.qliktech.com.

The Recently Opened Documents tab contains a list of recently opened 
documents and web pages. Just click on one of them to re-open it. 

Figure 2.  The QlikView Start Page, Getting Started tab
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The Open in Server tab contains a list of recently used QlikView Servers 
and an easy-to-use interface for connecting to any other QlikView Server. 
Once you have selected a QlikView Server, QlikView will connect to it and 
show a list of available documents, which can then be opened with a single 
click. We will not use the Open in Server tab in this course.

Basic Layout and Navigation
Remember, a QlikView file contains everything the user needs to perform 
meaningful data analysis, including the data itself, the load script and all the 
layout information, objects and sheets defined by the QlikView layout 
designer. 

Basic Layout

Remember, the sheet is the basis for layout in QlikView. A QlikView docu-
ment can have one or more sheets on which the sheet objects are placed. 
Each sheet can contain many sheet objects. The sheets have no influence on 
the logic of the data structures - if two fields are logically connected, it does 
not matter if they are located on the same sheet or on different sheets. The 
logical result when making selections will be the same. That said, sheets can 
be ordered in such a way as to present the appearance of a logical progres-
sion.

Tip: by right-clicking on a document in the Recently Opened Docu-
ments list, you gain access to a menu with the following useful com-
mands: 

Open "document" Without Data: Opens the document but skips table 
and field data. What you get is a layout with all sheets and sheet objects 
in place but empty. This feature can be useful, for example, for opening 
corrupted documents or for avoiding long waits when opening very large 
documents for a small change in the layout (of course, you will need to 
re-run the script to repopulate the document after the changes).

Open "document" and Reload Data: Opens the document and performs 
an immediate reload from the source data.

Browse Documents in Folder: Opens the folder containing the docu-
ment in the list.

Remove "document" From This List: Removes the document from the 
list of recently used documents. The actual document file remains 
unchanged where it resides.
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Sheet objects are at the heart of this course. They include list boxes, table 
boxes, multi boxes, statistics boxes, current selections boxes, many different 
types of charts, text objects, buttons and sliders, and others.

In some cases it might be advantageous to remove the sheet tabs and provide 
alternative methods of navigation. This is possible, but not covered in this 
course.

Figure 3.  The Sheet Objects Menu
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Before we go any further, we will take a moment to prepare our develop-
ment environment in QlikView. 

Basic Navigation

Since QlikView is a Microsoft Windows application, standard Windows 
menus and toolbars are used to navigate a QlikView document. Detailed 
information about each menu item and toolbar icon can be found in the 
QlikView Reference Manual and the Online Help.

The sheet is the basis for navigation in QlikView. All sheets have tabs 
attached to them labeled with the sheet name. Clicking on the tab activates 
the sheet. If the Sheets toolbar is active you may also activate a sheet by 
selecting it in the toolbar dropdown. Toolbars are activated on the View 
menu.

Figure 4.  The Basic Components of a QlikView Page — A: Tabs, B: List Boxes, C: 
Active Charts, D: Current Selections Box, E: Minimized Charts
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Figure 5.  View Menu Toolbars

Figure 6.  The Sheets Toolbar dropdown 
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EXERCISE – SETTING UP YOUR ENVIRONMENT

Do: 
1 Navigate to the c:\QlikViewTraining\DesignerI\Chapter3 directory and 

open the QVDesigner1_Chapter3.qvw file, or, if you plan to do all the 
exercises in a linear progression, open the QVDesigner1_Student.qvw 
file and continue to use it in subsequent chapters. This file is located in 
the c:\QlikViewTraining\DesignerI\ directory. Course files and data will 
still be accessed in the chapter directories.

2 Save a copy of the file to preserve the original in case you want to start 
again from the beginning later. Do this by using the File | Save As com-
mand. There is also a QlikView file ending in “_Solution.qvw” contain-
ing the completed exercise for your reference.

3 In many environments, consideration should be given to the amount of 
screen real-estate a QlikView application can use. Some organizations 
might have standards around the display resolution to be used when 
deploying applications. QlikView provides tools to address these 
requirements. Explore the View | Resize Window command to set the 
default value

4 You can also manipulate the size of individual sheets using the View | 
Zoom command and Apply Zoom to All Sheets. Experiment with the 
Zoom command in the QVDesigner1_Chapter3.qvw file. Remember, 

Figure 1.  Use Resize Window to set the desired resolution
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you can always return to the original settings by selecting Zoom | 100% 
for any sheets you have modified, or you can select Apply Zoom to All 
Sheets to set every sheet to the level of the current sheet.

5 Take this opportunity to activate the toolbars of your choice for the 
class. At minimum, you should use the Standard and Navigation tool-
bars. Note, too, that the toolbars can be moved, floated and docked by 
clicking and dragging on the dotted line to their far left. Hold down the 
left mouse button and drag to any position you like. The toolbars can be 
docked to any side of the QlikView application window. All toolbars are 
completely customizable and may contain any of the available command 
buttons. Experiment with toolbars to obtain a good working environ-
ment. Obviously, you can change it later, if you so desire.

6 Go to the Settings | User Preferences menu and navigate to the Save 
tab. Configure this tab for maximum backup by checking the settings, as 
below:

Figure 2.  Moving a toolbar by clicking and dragging on the dotted line to 
the far left

Note: Feel free to experiment with these settings. Remember that the 
original QVDesigner1_Chapter3.qvw file can be used if you have prob-
lems and want to start fresh. Just be sure if you open it to save it immedi-
ately with another name, as instructed in the exercises.
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4 SHEETS AND SHEET OBJECTS

This chapter covers the basic architecture of a QlikView file, the sheet. A 
QlikView document requires at least one sheet on which sheet objects are 
displayed. In this chapter, you will create, name and move a sheet, and also 
place basic objects on a sheet, as well as copy objects between sheets. 
Remember, even when several sheet objects have been placed on several dif-
ferent sheets, all sheet objects are still connected by the underlying QlikView 
associative logic.

Sheet Basics
This section of the course presents the basic points of creating and modify-
ing sheets.

Create Sheet

To keep the layout clear, you should avoid placing too many objects on a 
single sheet. Create new sheets to accommodate more sheet objects.

If you want the new sheet to hold several objects that are already displayed 
on another sheet you can make a copy of this existing sheet by right-clicking 
it and choosing Copy Sheet from the Sheet menu, or you can add a new 
sheet and copy specific sheet objects to the new sheet from existing sheets.

To create a new sheet, choose Add Sheet from the Layout menu, or click on 
the Add Sheet icon in the design toolbar. 

A new sheet is created and given a default name.

The Sheet Title can be set in the Sheet Properties | General page. To open 
this dialog, right-click the new sheet and choose Properties from the Sheet 
menu, or select Sheet Properties from the Settings menu.

Sheet Properties

You can adjust any of the sheet properties, either by right clicking in a blank 
area of the sheet and selecting Properties from the dropdown menu or via 
the Settings menu.

Objectives
• Create a sheet, name and move a sheet
• Place objects on a sheet
• Copy objects between sheets
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Sheet Order

You may rearrange the order of the sheets by right-clicking any tab and 
choosing Promote (<—) Sheet or Demote (—>) Sheet from the object 
menu.

Sheet Delete

A sheet can also be removed by placing your cursor over the sheet tab or in 
a blank area of the sheet, right clicking and choosing Remove from the 
menu. Remember, deleting a sheet removes any objects it contains, as well.

Add Objects

To create list boxes on a sheet and show fields and their values, click Select 
Fields in the Layout menu. This opens the Fields page in the Sheet Proper-
ties dialog. This dialog page is also displayed when you right-click the sheet 
and choose Select Fields from the Sheet menu.

You can move fields between the columns by selecting them and using the 
buttons Add > or REMOVE. By doing a SHIFT-click, multiple, contiguous 
fields can be selected. By doing a CTRL- click, multiple, non-contiguous 

Tip: For easier sheet reordering (to promote and demote sheets), use the 
buttons available on the design toolbar: 

Figure 1.  Toolbar Icons: Create, Promote and Demote Sheets, Sheet Proper-
ties 

Figure 2.  Using the Right-click menu to delete a sheet.
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fields can be selected. Clicking the Add All >> button moves all fields to the 
Fields Displayed in Listboxes window. Accept the changes by clicking OK.

Sheet Objects
Sheet objects include all the various types of objects available to you as a 
QlikView layout designer. Most of these objects will be covered in either this 
or subsequent designer courses. For now, it is sufficient to list them. Sheet 
objects include:
• List Boxes

Figure 3.  Sheet Properties: Fields Tab

Note: a single field (list box) can be displayed several times on the same 
sheet and can also exist on different sheets of the same QlikView docu-
ment simultaneously.
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• Statistics Boxes
• Multi Boxes
• Table Boxes
• Charts
• Input Boxes 
• Current Selections Boxes
• Buttons
• Text Objects
• Line/Arrow Objects
• Slider/Calendar Objects
• Bookmark Objects
• Custom Objects
• System Tables

The Sheet Objects menu was shown previously. It is also possible to choose 
sub-types for some sheet objects. For instance there are 12 different chart 
types available.

Activating Sheet Objects

Most sheet objects can be activated by clicking the title caption. Normally 
this results in the caption changing color or hue. If the sheet object lacks a 
caption, it will still have a click-sensitive area located along the upper edge, 
with the same functionality.

Moving Sheet Objects on a Sheet

To move a sheet object to another place on the same sheet:

1 Click+hold on the sheet object’s caption.
2 Drag the sheet object to the desired position.

Resizing Sheet Objects

To resize a sheet object:

1 Hover the cursor along the sheet object’s frame or preferably at a corner 
of the sheet object.

2 When a double-headed arrow appears, click+hold and drag the frame 
until the sheet object is the size you desire.

Certain objects size differently, for example, multi boxes, the different table 
types and statistics boxes. These cannot be resized by dragging further than 

Note: for future reference, the System Table sheet object is actually a 
pivot table chart pre-built to include System fields.
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to eliminate any horizontal scrollbars. Instead, the column separators can be 
used. 

Hover the cursor inside a statistics box or multi box until you find the invis-
ible column separator. Its position is identified when the mouse pointer 
changes to a double-headed arrow with a vertical bar ( ). You may 
click+hold and drag the separator to the desired column width. If you dou-
ble click the separator, the column will be adjusted to the width of the lon-
gest (widest) data item in that column.

Copying Sheet Objects on the Same Sheet

To copy sheet objects:

1 CTRL-click+hold the caption of the sheet object
2 Drag the copy of the sheet object to the desired position
3 Release the CTRL and mouse buttons. (Remember to keep holding down 

the CTRL key during the entire operation)

This method creates identical copies (clones) of the sheet object.

Moving or Copying Sheet Objects to Another Sheet

To move a sheet object from one sheet to another:

1 Click+hold the sheet object’s caption
2 Drag the sheet object to the tab area and drop it on the target tab

The sheet object can now be found on the selected sheet in exactly the same 
location as it was on the original sheet.

To copy a sheet object from one sheet to another:

1 CTRL-click+hold on the sheet object’s caption
2 Drag the object to the tab area and drop it on the target tab

A copy of the sheet object has now been created on the selected sheet in 
exactly the same location where it was on the original sheet.

Alternative Keyboard Commands

The following key combinations can be used for editing the layout:
• CTRL +X (cut)
• CTRL +C (copy)
• CTRL +V (paste)
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The arrow keys can be used to move sheet objects, giving you a more precise 
way to position sheet objects than can be achieved with a mouse. 

To use this method:

1 Click the sheet object’s caption.
2 Hold down CTRL and depress an arrow key to move the sheet object one 

pixel at a time in the desired direction.
3 Hold down CTRL + SHIFT and depress an arrow key to move the sheet 

object 10 pixels at a time in the desired direction.

Working with Several Sheet Objects at the Same Time

Most changes to the layout can be made with more than one sheet object 
active.

To have one or more sheet objects active at the same time, do one of the fol-
lowing:

1 The most convenient way to activate several sheet objects is to do a 
SHIFT-click on the captions of all the desired sheet objects.

2 You can activate all sheet objects on the sheet at once by choosing Acti-
vate All from the Edit menu (or doing a CTRL+A).

3 Or you can click and drag a rectangle around a group of sheet objects to 
activate them all at once, but this method may prove difficult in practice, 
since sheet objects are not always aligned or in close proximity to one 
another and the rectangle must completely encompass the entire outline 
of all sheet objects you want to select.

Removing Sheet Objects

To remove a sheet object

1 Right-click the sheet object.
2 Choose Remove from the Object Menu.

Alternatively:

1 Click the caption of the sheet object to activate it. 
2 Press the DELETE key to remove the sheet object.

Obviously, multiple sheet objects can be selected using the techniques 
described above, and then removed using either the DELETE key or Object 
Menu | Remove.

Note: When using the keyboard copy and paste commands, be aware 
that the pasted copy of an object will probably be placed directly on top 
of the original object if it is pasted to the same sheet. This can make it 
appear that no copy was made. Click and drag the top (new) object to 
confirm.
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EXERCISE – CREATING A WORKSPACE

Do:
1 Navigate to the c:\QlikViewTraining\DesignerI\Chapter4 directory and 

open the QVDesigner1_Chapter4.qvw file, or, if you are doing all the 
exercises in a linear progression, open the QVDesigner1_Student.qvw 
file and continue to use it in subsequent chapters. This file is located in 
the c:\QlikViewTraining\DesignerI\ directory. Course files and data will 
still be accessed in the chapter directories.

2 Save a copy of the file to preserve the original in case you want to start 
again from the beginning later. Do this by using the File | Save As com-
mand. There is also a QlikView file ending in “_Solution.qvw” contain-
ing the completed exercise for your reference.

3 Create a new sheet.
4 Promote the sheet so that it appears between the Sheets and Basic 

Objects sheets.
5 Re-name the sheet by re-labeling the tab, calling it Workspace. For 

extra-credit, copy the text object sheet title from the Basic Objects sheet 
to your new sheet and change it to Workspace

6 Open the View menu and select Design Grid.

Tip: the Design Grid allows you to easily size and place objects even with 
their captions turned off.
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7 Copy the Month, and Year list boxes from the Basic Objects sheet to the 
Workspace sheet.

8 Copy the Day multi box from the Basic Objects sheet to the Workspace 
sheet.

9 Add list boxes for Salesperson and Customers to the Workspace sheet. 
Note: use the field CompanyName and label it Customers (Note: the List 
box object will be covered in detail in a subsequent chapter. You may 
skip this step now, if desired.)

10 Re-position the list boxes on the sheet
11 Experiment with creating a sheet and copying the entire contents of an 

existing sheet to it.
12 Turn off the Design Grid
13 Save your work.
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5 THE LIST BOX

This chapter presents the most common QlikView object, the list box, and 
explains some of its most important uses in a QlikView application. The list 
box is also used here to demonstrate one of the simplest ways of making a 
query in QlikView. The chapter concludes with a discussion of the Proper-
ties of a list box, followed by a short exercise. 

Introduction
The list box is the most basic sheet object on the screen. It contains a list of 
all the possible (distinct) values of a specific field. In a list box you often 
make selections and look at logical connections and associations.

The Importance of the List Box

The list box illustrates the most important aspect of QlikView’s revolution-
ary power to transform the way analysis is done today. If you understand 
the list box, you will have gone a long way toward understanding QlikView.

Since the list box contains a list of all possible values of a specific field 
loaded from the source data, each row in the list box can represent several 
records in the loaded table, all with identical values of the field the list box is 
displaying. Selecting one value in the list box may, thus, be equivalent to 
selecting several records in the loaded table.

It is this selectability that makes the list box so important and so powerful.

Making a Query

To make a query using a list box, all you need to do is click. In the example 
below, compare the two screens to see the impact of simply clicking Helen 
Brolin in the SalesPerson list box.

Objectives
• Understand the versatility of the list box
• Make a query using a list box
• Understand list box properties

Figure 1.  List box containing the values of the SalesPerson field
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Figure 2.   The Sample sheet with nothing selected

Figure 3.  Clicking on Helen Brolin in the SalesPerson list box changes everything
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What Happened?

Please notice that the list boxes for Customers and Contact changed to show 
only Helen Brolin’s accounts. The list boxes at the top of the screen repre-
senting time (Month, Year and Day) have also changed to show the dates 
when Brolin made sales. Finally, the selection count of Customers informa-
tion in the bottom center of the screen, as well as the Orders Per Year chart, 
have also changed to reflect only those sales associated with Helen Brolin.

In other words, the data cell you just clicked turned green, whereas all the 
other data cells in the list box turned gray. Changes occurred in the other list 
boxes as well. Data cells that correspond to your selection remain white, 
while everything else is grayed out. 

When data cells are gray it means that the data is incompatible with the 
selected data. QlikView does not associate these data values with your selec-
tions. They are excluded.

Thus, we can draw many conclusions from this simple query.

Performing a Simple Search

List boxes are searchable. To enter a search string, click on the list box 
header (the caption) and then simply type the search string. The search 
string will appear in the pop-up search box. As a result, QlikView will dis-
play all the values of the selected field that match the criteria of the search 
string. When you press ENTER or click on one of the cells in the result, the 
value(s) become(s) selected.

The search box will close automatically when you hit ENTER, ESC, or click in 
the layout.

If several list boxes are active (SHIFT-click on their headers to make them 
active), they are all included in the text search. You cannot press ENTER to 
select the resulting value until there are optional values in only one of the 
active list boxes.

Figure 4.  Searching for customers with the letters "ar" in their name

Note: By keeping the CTRL key depressed when pressing ENTER, the selec-
tions from the text search will be added to any previous selections.
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Text search

The simplest way of searching is text search. QlikView will search for field 
values matching a text string that you type. When you start typing text, it 
will by default appear between two * wildcard characters (see below), i.e., 
you will search for any field value containing the search text. You can 
remove either or both wildcard characters or provide different ones, such as 
a “?”, to change the nature of the search.

Wild card characters may appear several times in the search string, regard-
less of their location: 

* Any number of arbitrary characters

? Any single character

Searches can also be used to exclude values. For example, if you needed to 
select all the values in the Customer field that did not end in “er” you could 
first perform a search for those values, and then choose Select Excluded by 
right clicking (while hovering over the list box) and choosing it from the 
drop down menu, as in the figure, below.

Note: If a selection has already been made, there are two ways in which a 
text search can be interpreted: either you search only among the optional 
values or you search among all values, i.e., you include the excluded val-
ues in the search. To set the search mode, you can either select or deselect 
Include Excluded Values in Search on the General page of the User 
Preferences dialog. This mode can also be set on certain individual sheet 
objects.

Figure 5.  Searching for customers whose name begins with "ar" (by remov-
ing the leading asterisk)

Figure 6.  Searching for Customers whose names end in "er" (by removing 
the trailing asterisk)
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Numeric Search

Numeric values can also be used in search criteria.

Fuzzy Search
Fuzzy search compares and sorts all field values according to their degree of 
resemblance to the search string. A tilde " ~ " -character is displayed in front 
of the search string. Fuzzy search is especially useful where misspelling is an 
issue. It can also help you find values that are near-identical to each other.

Using Expressions and Complex Searches

You can perform searches based on expressions by starting the search string 
with an equal sign = or greater than > less than <, etc.

List Box in Action

Multiple Selections in One List Box

You can select more than one value in the same list box:

1 To select several values in a sequence, click and hold the mouse button 
down, then drag over the values you wish to select.

2 To select several values that are not in a sequence, hold the CTRL key 
down and click the desired field values, one after the other.

Multiple selections within a single list box (i.e., in the same data field) are 
interpreted as a logical OR between the selections.

Figure 7.  Select Excluded from the right click (cascade) menu of the list box
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Simultaneous Selections in Several List Boxes

Selections can be made in multiple list boxes simultaneously. Simultaneous 
selections in different list boxes are interpreted as a logical AND between the 
selections. For example:

1 Make sure that you are still viewing the sheet Sample.
2 Clear all selections using the Clear button or select it from the Selec-

tions menu.
3 Select 2008 in the list box Year.
4 Select Mar in the list box Month.

This selects all sales made in 2008 AND during the month of March.

Figure 8.  Interpreted as a logical OR between the selections listed in the Current 
Selections box in the upper left corner of the screen
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Clearing Selections

Selections can be cleared in many different ways, including the following:

1 Click a second time on your selected value to de-select it.
2 Select some other values from the gray area of the same list box. When 

you select data that is incompatible with your previous selections, the 
old selection is cleared.

3 Click the Back button  in the toolbar. QlikView will store up to 
100 selections in memory. Each click takes you back one-step.

4 Click the Clear button  in the toolbar. All your selections disap-
pear.

Figure 9.  Simultaneous selections in two list boxes
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5 Hover over your selection in the Current Selections box and right click 
Clear or click on the Clear button if it has been activated in the proper-
ties of the Current Selections box:

Locking and Unlocking Selections

Locking

It is sometimes convenient to lock selections, i.e., to make them Clear-but-
ton proof. Locked selections are displayed in blue with yellow text. You 
might want to work with one year’s worth of data, or focus on a particular 
sales region, for example, and not have to worry that pressing the Clear but-
ton would undo your selection status.

There are two methods for locking selections:

1 Make your selections in one or several list boxes.
2 Click the Lock selections button in the toolbar. All selections 

made in the list boxes are locked.

Or:

1 Make your selections in one or several list boxes.

Note: Clicking on the Clear button applies the start selection of a 
QlikView document, which can be configured, as below. The drop-down 
menu offers the following options.

Clear 
The start selection of a QlikView document. This command can also 
be invoked via the keyboard shortcut ctrl+shift+d.
Clear all
Clears all selections, excluding locked ones.
Unlock and Clear all
Unlocks and clears all selections.
Set Clear State
Sets the current selection as Clear State.
Reset Clear State
Resets Clear State to no selections.

Figure 10.  Current Selections Box with Clear button activated
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2 Right-click in a list box where a selection has been made. This opens an 
object menu.

3 Choose Lock from the menu.

In this case, only the selected data in the active list box is locked. Selections 
made in other list boxes are unaffected. A selection that has been locked can 
only be cleared by one of the previously described methods, namely the 
Back command.

Unlocking

There are two main methods for unlocking locked selections:

1 Click the Unlock Selections button in the toolbar. All locked 
selections in all list boxes are unlocked.

Or:

1 Right-click in a list box where a selection has been locked. The object 
menu opens.

2 Choose Unlock from the menu.

You have now unlocked all locked selections in the active list box. Locked 
selections made in other list boxes remain locked.

The only way that you can unlock and clear the selection with a single com-
mand is to choose Unlock and Clear from the Selections menu. Unlocking 
does not imply deselecting as well. After unlocking, the selection state 
remains in effect.

A Note about Searches and Selections in other Objects

Making selections and searching for field values is not limited to list boxes. 
In QlikView, you can make selections and searches directly in any type of 
table and in multi boxes. You can also make selections directly in charts by 
clicking and dragging over the values. You will learn more about these capa-
bilities in subsequent chapters. 

Beacons

Indicators (beacons) are colored dots that sometimes appear on tabs and in 
the right-hand corner of the status bar. Indicators are there simply to remind 
you of selections that have been made in fields that are not available on the 
sheet that you are currently viewing. Since all sheets of a QlikView docu-
ment are fully interconnected, such selections will most likely affect what is 
displayed on the active sheet - even when they are not immediately apparent. 
This is the main reason for having indicators.

Selection indicators may also appear in the upper right-hand corner of the 
data fields in the QlikView tables: table boxes, pivot tables and straight 
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tables. This is a useful option as the selections in tables are not themselves 
color coded. The option is selected/deselected in the User Preferences | 
Objects dialog.

Selection indicators will appear in the current selections box as well as in the 
free-floating current selections text box, to distinguish between selected and 
locked values.

The color of the indicator follows the general color scheme of a:
• green dot for selected values
• blue dot for locked selections
• red dot for de-selected values in AND-mode (not common)

Creating a List Box
Creating a list box is a simple process:

1 Create a new list box by choosing New Sheet Object – List Box from 
the Layout menu. You can also right-click in a blank area of a sheet and 
select New Sheet Object – List Box from the menu. 

2 Select the field SalesPerson
3 Click OK to generate the list box.
4 You can adjust the width of the list box by clicking on the edge of the 

table with the mouse cursor, keeping the mouse button depressed and 
dragging the edge. By clicking on one of the four corners of the list box 

Figure 11.  Beacons example
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instead, you can adjust its width and height simultaneously. The field 
name displayed as the column heading (caption) of the list box can be 
edited in the List Box Properties | General page.

After some adjustments, the List box could look like this:

Properties of the List Box
This section shows the settings available for list boxes. When designing 
applications in QlikView, it is common to copy objects and manipulate their 
appearance and functionality by changing the object properties. Many of the 
settings found in list box properties are common to the various object types 
in QlikView. Consequently, this section is an overview of object properties, 
in general.

To review list box Properties, right-click on one and choose Properties. 

Figure 12.  The finished list box

Throughout the course we will return to the Properties dialogs of objects 
to make changes. The single biggest thing to learn in QlikView might 
well be the different properties available for different objects and remem-
bering the tabs to navigate to find them. Be assured, though, that the sim-
ilarities far outweigh the differences. Once you are familiar with these 
main tabs, you will know the majority of the properties available for all 
objects, not just list boxes.
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General Tab

Some of the more common settings are highlighted, above. Know, too that 
clicking on the Help button will bring up meaningful, context sensitive help.

The Show Alternatives box Toggles whether a selection directly in the active 
field list box is to exclude the other values of the field or not. If Show Alter-
natives is checked, all values except the selected value will be displayed as 

Figure 13.  General Tab

Figure 14.  Example Help Screen
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options, but may become excluded by association with selections in other 
fields. 

Otherwise, all other values are shown as excluded by default. This option is 
not available for calculated fields.

Although there is significant impact to using the Show Frequency box, and, 
as such, this capability should be used with caution, a field represented in a 
list box with this selected will display the number of occurrences of the field 
value in the internal data structure. This can be especially useful when look-
ing at system fields.

Although more relevant to the advanced section of the class, you should be 
aware, now, that list boxes can also be created based on the result of an 
expression, or can display the contents of a group of fields defined else-
where.

The figures below display these two options.

Since the available options in the General tab change slightly depending on 
the object type, we will return to it later in the course.

Figure 15.  The system field $Field showing Frequency

Figure 16.  List Box, Expression Figure 17.  List Box, Group (Sales)
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Presentation Tab

The Presentation tab is used to manipulate the layout of the list box cells 
(the space occupied by each list box value) and to help determine the display 
of list box contents. Some of the more commonly changed settings on the 
Presentation tab are noted in the figure, below:

Note that list box data can be presented in Single or Multiple Columns with 
alignments adjusted for text and numbers.

Sort Tab

The Sort tab is used to set the sort order of the values in the sheet object. 
Some sort options may not be available for some sheet objects. The sort 
options for list boxes are shown in the figure, below.

Figure 18.  Presentation Tab
68



QlikView Designer I | THE LIST BOX
Number Tab

Each field has a default number format which can be set in the Document 
Properties | Number page. It is however possible to use a separate number 
format for an individual list box (sheet object). To do this, the alternative 
Override Document Settings box must be checked, and a number format 
in the tab control below can be specified.

Figure 19.  Sort Tab

Figure 20.  Number Tab
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Font Tab

The Font tab controls the Font, Style and Size to be used in the list box.
 

Layout Tab

The Layout tab has many options. Note that a layout setting will apply to 
the current list box or object only if it is made from the Properties page of 
the list box or object. Alternatively, a layout setting will apply to all objects 
of the specified type(s) in the document, if it is made from the Document 
Properties page.

Some of the more important settings on the Layout tab include:

Figure 21.  Font Tab
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Clicking on the Apply Theme button opens a dialog box, allowing the user 
to select a theme from a folder or network location.

Figure 22.  Layout Tab
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Figure 23.  Available Themes, typically located in the Program 
Files\QlikView\Themes directory
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Caption Tab
.

Help Text can be added by clicking on the ellipsis icon to open the expres-
sion editor, or simply by typing into the box.

Remember, the contents of each of these tabs change, depending on the type 
of object you are working on. So far, we have focused on the properties of 
list boxes. Additional options on the Object Menu include:

Figure 24.  Caption Tab
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Figure 25.  The Object Menu (with a list box selected)
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EXERCISE – LIST BOXES

Do:
1 Navigate to the c:\QlikViewTraining\DesignerI\Chapter5 directory and 

open the QVDesigner1_Chapter5.qvw file, or, if you are doing all the 
exercises in a linear progression, open the QVDesigner1_Student.qvw 
file and continue to use it in subsequent chapters. This file is located in 
the c:\QlikViewTraining\DesignerI\ directory. Course files and data will 
still be accessed in the chapter directories.

2 Save a copy of the file to preserve the original in case you want to start 
again from the beginning later. Do this by using the File | Save As com-
mand. There is also a QlikView file ending in “_Solution.qvw” contain-
ing the completed exercise for your reference.

3 Go to the Workspace sheet.
4 Right click in a blank area of the sheet and choose New Sheet Object: 

List Box. 
5 Select a field for your new list box (General tab).
6 Experiment with settings on the tabs in the Properties dialog as follows 

— 
7 Change the Title (General tab)
8 Deselect Single Column and Order by Column (Presentation tab)
9 Sort on either Numeric Value or Text depending upon the type of data in 

the list box (Sort tab)
10 Either Override Document Settings and change the number format if 

you are working on a numeric list box (Number tab), or make changes 
to the display Font if you are working on a text list box (Font tab)

11 Move to the Layout tab and adjust the border settings. Make selections 
in the Options group and examine the effect.

12 On the Caption tab, create a Multiline Caption. Add Special Icons to 
your list box.

13 Click OK and save your work.
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6 THE TABLE BOX

This chapter introduces table boxes and gives you a chance to build a table 
box in your QlikView file.

By definition, the table box is a sheet object that shows several fields simul-
taneously. 

Introduction
Think of a table box as a combination of list boxes. Instead of placing each 
field in its own object separately, however, the table box combines them. 
The content of every row is logically connected. The columns may be 
fetched from different input tables, letting the user create tables from any 
possible combination of input tables.

So, when you want to present the contents of several list boxes in one table, 
you need a table box.

As the name implies, a table box is a table with rows and columns. Each col-
umn corresponds to a field (just like the column in a list box). The rows cor-
respond to every possible combination of data in these columns.

Objectives
• Understand when to use table boxes
• Print from a table box
• Export data from a table box to a text file

Figure 1.  Three list boxes and a table box with the same contents
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Creating a Table Box
Creating a table box is a simple process:

1 Create a new table box by choosing New Sheet Object – Table Box 
from the Layout-menu, or you can right click in a blank area of the sheet 
and select New Sheet Object – Table Box from the menu. 

2 Select the fields SalesPerson, CompanyName, and ProductName.
3 Click OK to generate the table box.
4 You can adjust the width of the table box by clicking the cursor on the 

vertical right edge of the table and dragging.
5 To adjust the column widths you can drag the column separators with 

the mouse. If you double-click with the cursor over the border between 
two columns, the width of the column to the left will be automatically 
adjusted to fit the data. If the cursor is in the caption area, the column 
width will be adjusted to the title instead.

6 The labels displayed in each column can be edited in the Table Box 
Properties: General page. Change the label for CompanyName to Cus-
tomer.

After some adjustments, the table box may look like this:

There are of course numerous settings for the layout, sort order, etc. of table 
boxes. They are found under Properties in the object menu of the table box.

Selections in Table Boxes
With QlikView’s associative logic, the contents of the table box are automat-
ically updated when you make selections in other objects.

Figure 2.  The finished Table Box
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Selected values are marked green in the table box while you select, just like 
the cells in a list box, but when you release the mouse button they revert to 
their original color. The size of the table is adjusted to display only the result 
of your selection.

Selections in a column can be indicated with a beacon to the right of the 
field name.

When you right-click a certain column in a table box, an object menu will 
appear, containing many of the options found in the list box object menu.

Sorting in Table Boxes
There are two different meanings of sorting in table boxes. First of all, you 
can set the order in which the columns are displayed, from left to right. This 
is done by clicking the caption of a column and dragging it to a new posi-
tion. A blue outline of the field indicates that you are performing a drag-
and-drop operation. The order can also be set in the Table Box Properties: 
General dialog by means of the buttons Promote and Demote.

Secondly, the rows in the table box can be sorted according to the sort order 
for the values of specific fields in the table box. This is done in the dialog 
Table Box Properties: Sort. There you can also set a Sort Priority by mov-
ing fields up or down in the list. The sort priority is independent from the 
order in which the columns are displayed.

An alternative and convenient way is to simply right-click the column of the 
field you wish to sort on and select the Sort command from the table box 
menu. Double-clicking the column header works equally well. This will also 
bring the field name to the top position of the Sort Priority list. Repeated 
use of this command toggles the sort order for the selected field between 
ascending and descending order. A small arrow icon  at the top of the 
column indicates for which field the table is sorted and if the sort order is 
ascending or descending.

Figure 3.  Selections in a column, displaying indicator beacon
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More Table Box formatting options
In addition to the dialog pages Table Box Properties: General and Sort, the 
pages Presentation, Style, Number, Font and Layout offer numerous other 
possibilities for formatting table boxes.

The dialog pages Number, Font and Layout and Caption are almost the 
same as for list boxes and do not require further presentation. We will 
instead take a closer look at the pages Presentation and Style.

Setting the alignment of columns

In the dialog Table Box Properties: Presentation you will find the options 
for text alignments in the columns. Alignment of text and numbers can be 
determined separately. Select one of the Fields and make the necessary 
adjustments under Alignment.

Applying a formatting style

For the various table types (table boxes, pivot tables and straight tables) a 
selection of pre-defined layouts are available from the dialog Properties: 
Style. The selection of styles is directly related to design best practices. Not 
all styles are appropriate in all situations.

Printing data from a table box
Sometimes it is desirable to have a paper copy for a certain selection status, 
to use it in a report or some other external document. In QlikView you can 
print directly from the various table types. Printing a table box is done like 
this:

1 Right-click the table box and choose Print from the object menu.
2 Make appropriate adjustments to the printer options etc. from the Print 

dialog.
3 Click the Print button at the bottom of the dialog.

If you prefer to use the Print button in the toolbar, the process will skip the 
Print dialog and proceed directly with the printout. This button is active 
when a table box (or any printable object) is active and the computer has a 
printer installed.

Note: Notice the check box Omit Rows where field is NULL. If this 
option is selected for a certain field, rows lacking values for this field (i.e. 
rows where the field is NULL) will not be shown in the table box. Simi-
larly, this same formatting can be applied to charts and other QlikView 
objects to clean up the display of data.
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• You can also print directly to a PDF file using the command Print as 
PDF in the object menu.

• Additional printing, exporting and reporting capabilities are covered in 
subsequent QlikView training courses.

Exporting data from a table box to a text file
You can also export the contents of a table box or other table to a file. 

1 Right-click the table box and choose Export from the object menu.
2 Type a file name in the File name box in the dialog.
3 Choose a file type for the export. You can choose between comma-sepa-

rated (.csv), tab-separated (.tab), semicolon-separated (.skv), HTML, 
XML and Excel. You can also use the standard QlikView format for 
export files (.qvo).

4 Click Save to execute the export.

Another possibility is to use the command Send to Excel. This will export 
the table to Excel, which is then automatically launched if not already run-
ning. The table will appear in a new Excel worksheet.

In numerous practical applications, QlikView is used for exporting data pri-
marily to Excel, and the table box is often the preferred tool. Consequently, 
it is important to know how to work with table boxes. The exercises that 
follow will reinforce what you have learned so far.
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EXERCISES

Do:
1 Navigate to the c:\QlikViewTraining\DesignerI\Chapter6 directory and 

open the QVDesigner1_Chapter6.qvw file, or, if you are doing all the 
exercises in a linear progression, open the QVDesigner1_Student.qvw 
file and continue to use it in subsequent chapters. This file is located in 
the c:\QlikViewTraining\DesignerI\ directory. Course files and data will 
still be accessed in the chapter directories.

2 Save a copy of the file to preserve the original in case you want to start 
again from the beginning later. Do this by using the File | Save As com-
mand. There is also a QlikView file ending in “_Solution.qvw” contain-
ing the completed exercise for your reference.

3 Go to the Workspace sheet.
4 Create a table box containing the fields OrderID, OrderDate, Produc-

tID, ProductName, Quantity. 
5 Sort the table on OrderDate in descending order.
6 Let the column OrderID switch places with OrderDate. Move the col-

umn Quantity between OrderID and ProductID.
7 Apply the style Pyjama 1.
8 Go to the Properties of the table box and click on the Presentation tab.
9 Then CTRL-click on OrderDate and ProductID in the Fields window 

and mark the Dropdown Select checkbox and click on Apply, then OK.

Figure 1.  Setting the options for Dropdown Select to enable searching
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10 Select the following directly in the table: the product with the ID 5 and 
all order dates of 2008 by clicking on the Dropdown menus and typing 
2008 in the OrderDate dropdown and 5 in the ProductID dropdown.

11 Export the table to Excel using the command Send to Excel.
12 Minimize the table and create a new table box on the same sheet, con-

taining the fields CompanyName (label Customer), Address, PostalCode 
and City.

13 If your Workspace tab does not contain a list box for Country, create 
one now.

14 Select all customers in France (in the list box Country).
15 Export the selected customers' addresses from the table box to the file 

CustomersFrance.qvo. Be sure to note where you save the exported file!
16 Start Excel and open the file CustomersFrance.qvo from Excel.

Optional extra exercises

1 Set the table box to display two lines per row.
2 Choose the Basic style.
3 Clear your selections.
4 Align the values of the column PostalCode left.

Figure 2.  Activating Search on table fields

Figure 3.  The completed (extra exercise) table box
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7 THE MULTI BOX

This chapter introduces the multi box. 

The multi box offers the ultimate solution to the problem of displaying a 
large number of list boxes on the same sheet.

Introduction
A multi box is like a set of dropdown list boxes gathered within the same 
frame. As the picture illustrates, every field is represented by a row in the 
multi box. Multiple fields can be combined into a single multi box. In addi-
tion, the function Sort by Applicability (Multi Box Properties: General) 
ensures that fields relevant to a search are sorted upwards in the multi box.

There are a number of advantages of using a multi box instead of several list 
boxes:
• Less space is required in the layout. Thus, the layout may be less clut-

tered.
• It is possible to display a very large number of fields in a single multi 

box.
• The multi box excels at displaying the result of selections that result in a 

one-to-one relationship, since no data is shown until the selections 
define a single result in a multi box field.

Objectives
• Understand the unique value of the multi box
• Create a multi box
• Manipulate the fields in the multi box

Figure 1.  Compare the space used by the list boxes to that of the multi box
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Selections in Multi Boxes 
Selections can be made in any of the fields in a multi box.
• While a field in a multi box is closed, a value is shown only when it is the 

only possible (or selected) value in the field.
• You can open a field by clicking. The values of the field become available 

for selection, like in an ordinary list box.
• The list is automatically closed when you make a selection.
• Make multiple selections by click+drag or CTRL-click, just like in a list 

box.
• If you right-click in an individual field, you gain access to an object 

menu with essentially the same commands that can be found in the list 
box object menu.

Creating a Multi Box
The following procedure can be used to create a multi box.

1 Create a new multi box by choosing New Sheet Object – Multi Box 
from the Layout menu. Or you can use the icon on the design toolbar.

2 Select the fields Suppliers.CompanyName, Suppliers.Address, Suppli-
ers.City, Suppliers.PostalCode, Suppliers.Country, Suppliers.Fax, Suppli-
ers.Phone and Suppliers.ContactName.

Note: The last argument, however, implies that ordinary list boxes may 
well be the preferable solution for displaying fields primarily intended for 
making selections or otherwise generally illustrating one-to-many or 
many-to-many relationships.
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3 Bring the fields into an appropriate order by using the Promote and 
Demote buttons under the list of Fields Displayed in Multi Box.

4 Click OK to finish your multi box.

Resizing Multi Boxes 
You can alter the size of a multi box by clicking and dragging, much like you 
would a list box, but the method is slightly different:
• If you click + drag the lower right corner you may expand the multi box 

to remove any scrollbars.

Figure 2.  Using Promote and Demote to re-order fields

Tip: If you are still not satisfied with the order of the fields you can 
change it by simply dragging fields to a new place within the finished 
multi box.
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• Immediately inside the frame, to the far right of the multi box, is another 
position that can be manipulated with the mouse. If you click + drag 
here you can alter the width of the column where the field data is dis-
played.

• If you do the same in a position just left of the arrow buttons , you 
can alter the width of the labels column instead.

Formatting Multi Boxes 
As usual, you may alter the properties of the multi box if you right-click on 
it and choose Properties from the object menu. The Multi Box Properties 
dialog consists of the pages General, Sort, Presentation, Number, Font,  
Layout and Caption and offers roughly the same settings that we know from 
list boxes and table boxes.
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EXERCISES

Do:
1 Navigate to the c:\QlikViewTraining\DesignerI\Chapter7 directory and 

open the QVDesigner1_Chapter7.qvw file, or, if you are doing all the 
exercises in a linear progression, open the QVDesigner1_Student.qvw 
file and continue to use it in subsequent chapters. This file is located in 
the c:\QlikViewTraining\DesignerI\ directory. Course files and data will 
still be accessed in the chapter directories.

2 Save a copy of the file to preserve the original in case you want to start 
again from the beginning later. Do this by using the File | Save As com-
mand. There is also a QlikView file ending in “_Solution.qvw” contain-
ing the completed exercise for your reference.

3 Begin on the Workspace sheet and create a multi box with the fields 
OrderID, OrderDate, SalesPerson and CompanyName (Label: Cus-
tomer), Country and Shipper.

Optional extra exercises

1 Enlarge the right column of the multi box to have all values fully visible.
2 In the Multi Box Properties: Presentation page, select a color or color 

gradient of your choice for the closed multi box. If you would like to use 
the same pale color as in the existing multi box, you can alternatively use 
the Format Painter tool to transfer the properties from one object to the 
other. But be aware that you cannot use Undo to reverse the format you 
apply with the Format Painter.

3 Experiment with the Multi Box Properties: Presentation by choosing 
the Grid Style check box and setting the Limit Drop-Down To 6 lines.
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8 OTHER IMPORTANT BOXES

This chapter introduces three important QlikView objects: the search object 
statistics box, the current selections box and the text object.

Search Objects
Search objects can be used for searching for information anywhere in the 
document. They are created by choosing new sheet object from the layout 
menu or from the sheet object menu.

How it Works

The search object properties dialog is opened by choosing Properties from 
the Object menu. If the properties command is dimmed you probably don't 
have the privileges needed to perform property changes. 

To configure the search options, make selections on the General tab. Here 
you can decide to search all fields, or a specific list of fields.

Objectives
• Explore Search Objects
• Introduce the statistics box and current selections box
• Understand the flexibility of the text object

Figure 1.  The Search Object in action
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The Presentation tab gives you the chance to define the look and feel of 
your search object. You can affect the search result display and the visual 
style. In the font tab you can specify the font style and size of the text in the 
search object. The layout tab gives you the chance to specify how the search 
object should appear on the layout. As with other QlikView objects, this 
includes settings for shape border and the layer on which the object should 
reside. Finally, on the Caption tab, advanced settings can be made for the 
caption of the search object.

The Statistics Box
A statistics box does not display field values, but, rather, it presents statistics 
based on a particular field value. The statistics box can be configured to dis-
play any number of up to fifteen statistical functions. The default settings 
are: Total count, Sum, Average, Min value and Max value. A statistics box 
for Sales (LineSalesAmount) can be found on both the Sample and the Basic 
Objects sheets and is reproduced, below. The contents of the statistics box 
change based on the selection status in the QlikView file (what the user 
clicks).

Figure 2.  The Presentation tab of the Search Object
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The Current Selections Box 
The current selections box, as its name implies, displays the selection status 
of your document. It is a good idea to place a current selections box on 
every sheet in your application. The current selections box lists all fields 
where selections have been made as well as the selected values or – if there 
are too many of them to display in the space allocated – the number of 
selected values. A current selections box can be found on both the Sample 
and the Basic Objects sheets and is reproduced, below.

Text Objects
Text objects are used for adding information to a QlikView document. They 
can be used to show text information or an image in the layout. They can be 
moved and positioned anywhere on a sheet, just like any other sheet object.

Text objects can also be used effectively for displaying the results of calcula-
tions, and to create backgrounds, borders and titles for groups of objects on 
a QlikView page.

Introduction

Think of a text object as a blank canvas for content. You can use it to create 
an introduction page for your QlikView application, or simply to display the 
data model that supports your analysis. Text objects can also be used for 
pictures and can also contain calculations. Some  examples of the uses of 
text objects:
• Images
• Expressions and Calculations
• Backgrounds
• Introduction Sheet Example

Figure 3.  A statistics box based on Sales (the LineSalesAmount field)

Figure 4.  A current selections box is dynamic, representing the selection sta-
tus from moment to moment.
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The chapter exercises will give you the chance to experiment with building 
text objects of your own.

Creating Text Objects

Like any other object in QlikView, the most common way to create a text 
object, aside from copying one that already exists, is to right click in a blank 
area of the layout to display the Sheet Object Menu and selecting New 
Sheet Object: Text Object. You can also click on the icon in the design tool-
bar. 

Backgrounds

A background text object can be as simple as a shaded color box on top of 
which you place minimized icons.

.

Figure 5.  Background text object called “Table Box Exercises” with three 
minimized objects displayed on top

Note: Text objects are great for backgrounds to call out a particular sec-
tion of your sheet, but you should avoid using them too often both 
because they can add to the visual complexity of the sheet, and because 
they can hamper the ability of your users and developers to access object 
menus using the familiar right-click method. That said, transparent back-
grounds can be used to provided borders and titles to groups of items 
that the eye should be drawn to together.
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EXERCISE: CREATE A SEARCH OBJECT 

Do:
1 Navigate to the c:\QlikViewTraining\DesignerI\Chapter8 directory and 

open the QVDesigner1_Chapter8.qvw file, or, if you are doing all the 
exercises in a linear progression, open the QVDesigner1_Student.qvw 
file and continue to use it in subsequent chapters. This file is located in 
the c:\QlikViewTraining\DesignerI\ directory. Course files and data will 
still be accessed in the chapter directories.

2 Save a copy of the file to preserve the original in case you want to start 
again from the beginning later. Do this by using the File | Save As com-
mand. There is also a QlikView file ending in “_Solution.qvw” contain-
ing the completed exercise for your reference.
Search objects can be used to search through one or several fields in the 
application. By using the search object, you can actually make selections 
in fields that are not present on the sheet where you have the search 
object.

3 Start on the Workspace tab
4 Start by adding the two list boxes Country and SupplierCountry
5 Right click on the sheet and open New Sheet Object and select Search 

Object.
6 Select the radio button Selected fields
7 Select the fields Country and Suppliers.Country.
8 Go to the Presentation page and select the check boxes for Include 

Excluded and Highlight Substring.
• Include Excluded - Will include values in the search that has been 

excluded by previous selections.
• Highlight substring - Will highlight in yellow what you have typed so 

far in values still possible.
9 Click OK to close the Properties dialog.
10 Click on the Search object to open it for searching.
11 Start typing S.

As you can see there will be a box with the search in both fields.
If there are more values than the box is allowed to show, only the num-
ber of matches will be seen in the result window.

12 Continue typing w in order to search for Sweden.
As you can see, the number of matches can now be seen in the Search 
result box and the typed values are highlighted in yellow.

13 Type the letter e and press Enter when only Sweden is available in both 
list boxes. 
Sweden is now selected in both list boxes. 
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14 Add another list box, ProductName to the sheet.
The products now available are products that has been sold to customers 
in Sweden, supplied by Swedish suppliers.

Extra Credit 

1 Find out what products have been sold to Spain by Canadian suppliers.
2 Now create a Search box that searches through all fields of the applica-

tion.

Tip: If you want to find different countries in the two list boxes, search 
for one country first, and click on the value in the list box where you 
want to make the selection. Then search for the other country and click 
on that value in the other list box.
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EXERCISE – CREATE A BACKGROUND TEXT 
OBJECT

Do:
1 Navigate to the c:\QlikViewTraining\DesignerI\Chapter8 directory and 

open the QVDesigner1_Chapter8.qvw file , or, if you are doing all the 
exercises in a linear progression, open the QVDesigner1_Student.qvw 
file and continue to use it in subsequent chapters. This file is located in 
the c:\QlikViewTraining\DesignerI\ directory. Course files and data will 
still be accessed in the chapter directories.

2 Save a copy of the file to preserve the original in case you want to start 
again from the beginning later. Do this by using the File | Save As com-
mand. There is also a QlikView file ending in “_Solution.qvw” contain-
ing the completed exercise for your reference.

3 On the Workspace sheet, right-click in a blank area of the layout to dis-
play the Sheet Object Menu and select New Sheet Object: Text Object. 
You can also click on the icon in the design toolbar.

4 In the General tab of the new text object, type something into the Text 
window. You could choose Sample Text Object Background, for exam-
ple.

5 Be sure the Representation dropdown is set to Text and that the two 
Scrollbar checkboxes are de-selected.
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6 In the Layout area at the center of the dialog, select Centered for Hori-
zontal Alignment and Top for Vertical Alignment.

7 Click on the Color box to change the background color. 
8 Experiment with the Transparency slider.
9 Click on the Font tab and make any changes you would like
10 On the Layout tab, confirm that the Bottom radio button is checked for 

the Layer. 
11 On the Caption tab, be sure the Show Caption check box is de-selected.

12 Click OK. Manipulate the text object on the sheet. Experiment with add-
ing borders. Save your work.

Images

Images (pictures, graphics, etc.) can be placed in text objects as follows:
• dynamically, by using an expression in the Text Window on the General 

tab
• automatically, by imbedding the image using the Info Load statement in 

the script
• manually, by connecting the image to the text object using the Image 

button on the General tab.

In the exercise that follows, we will place an image in a text object using the 
manual method.
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EXERCISE – CREATE A TEXT OBJECT BASED ON AN 
IMAGE

Do:
1 Assuming your working file, QVDesigner1_Chapter8.qvw (or the 

QVDesigner1_Student.qvw file, if you are doing all the exercises there)  
is still open, go to the Workspace sheet.

2 Create a new text object.
3 In the General tab, click on the Image radio button in the Background 

section. Click on the Change button, and navigate to the Files folder in 
your course materials directory.

4 Select the QV9_Banner.png file and click Open.
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5 Experiment with the Image Stretch and Alignment drop down menus 
by changing the selections, clicking OK and experimenting with the text 
object on your sheet.

6 Place the text object on your Workspace sheet and Save your work.

Expressions and Calculations

Text objects can be powerful displays of data and calculations. Anywhere 
you see the Ellipsis button  in QlikView is a place into which an expres-
sion can be entered. A text object can represent this expression anywhere in 
your QlikView file.

In the following exercise, we will use a QlikView expression and function to 
create a dynamic Text object that will display the most current data re-load 
for our QlikView file.
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EXERCISE – EXPRESSIONS AND CALCULATIONS

Do:
1 Go to the Workspace sheet.
2 Create a new text object.
3 In the Text window, type the following:

='[ Updated at ' & timestamp(reloadtime(), 'hh:mm on 
MMM DD, YYYY') &' ]'

4 Make the background color match the sheet. (Unless you have changed 
something, this will be white), or you can set the transparency to 100% 
and the background color will not matter. Click OK. The reload time 
should display.

5 Place the new object on the page.
6 Save your work.
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Introduction Sheet Example

An Introduction Sheet Text Object can serve as an informational first-stop 
for users. You can create an Introduction Sheet using a combination of indi-
vidual text objects formatted for the type of display or layout you are trying 
to obtain, or you can build your Introduction Sheet Text Object in some 
other application and simply insert it as an image in your QlikView docu-
ment. That is what we will do in the exercise below, depending on a previ-
ously created Introduction Sheet Object for our example.
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EXERCISE – INTRODUCTION SHEET TEXT OBJECT

Do:
1 Navigate to the How To sheet. If you are using the 

QVDesigner1_Student.qvw file, you will need to create the sheet.
2 Create a new text object.
3 There is no text to type into the Text window. Set the background to 

Image by clicking the Image radio button. Click Change and navigate 
to the Files folder. Click on the HowToSheet.png and click Open.

4 Select Keep Aspect from the Image Stretch dropdown and click OK.
5 Size the new text object on the sheet.

Other Examples

The following picture is a representation of the data model underlying the 
course materials. It was created using tools available to you in QlikView, 
and can be a powerful addition to your QlikView files, particularly in cases 
where developers or end-users need to understand the relationships between 
the source data.
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When you first activate the Table Viewer (available from the file menu), the 
layout of the tables might be a little cluttered. You can click and drag the 
tables to arrange them. Just be sure to click OK when you have finished 
improving the layout. 

Figure 1.  Layout designer course data structure

Tip: Arrange your layout view in the Table Viewer and click OK when 
you are done to preserve it for the next time you use the Table Viewer in 
QlikView.
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EXTRA CREDIT EXERCISE – SYSTEM SHEET AND 
DATA MODEL

Do:
1 Create an image of the data structure in your 

QVDesigner1_Chapter8.qvw file (or the QVDesigner1_Student.qvw file) 
using tools available to you from within QlikView (Hint: locate and use 
the Table Viewer).

2 Add a sheet to your layout. Name it System and insert a text object con-
taining the image of the data model created above. Be sure to format 
your text object appropriately, paying particular attention to the Back-
ground section of the General tab of the Text Object Properties.

3 Save your work.

Formatting, Resizing, Copying and Moving Text Objects

Text objects have similar format, size, copy and movement menus to other 
QlikView objects. The three tabs available to you when formatting text 
objects are: General, Font and Layout. Text objects can be resized, copied 
and moved like other objects.

Figure 2.  A: Click on the Export Image button to make a copy of your data 
structure and save it into the Files folder
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Sometimes you will place text objects on the page without borders, making 
it difficult to determine where to pick up and grab it for re-sizing. Rather 
than clicking through all the buttons to turn borders on and off again, sim-
ply turn on the Design Grid to see the borders of the text object for re-sizing.

Notice how simple it is to see where to click for re-sizing in the image below:

Figure 3.  Using the Design Grid to ease re-sizing objects without borders 
and captions
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9 CHARTS

Charts are a collection of graphical objects that can display one or several 
expressions plotted over one or several dimensions, such as "Total sales per 
Month." In QlikView, you will recognize the most common chart types: bar, 
line and pie charts, but several other types, including two kinds of tables, are 
also included as charts.

Chart Basics
Before we begin with the creation of charts, we are going to quickly explore 
some basic functionality with charts within QlikView.

Charts can be moved, sized and copied in the same way as other sheet 
objects.

You can duplicate charts using the following method within QlikView:

1 Press the CTRL key and keep it depressed while placing the mouse cursor 
on the header of the chart.

2 Press the mouse button and drag the chart to one side. While dragging, 
make sure that a small plus sign appears; if it does not, this means that 
you have released the CTRL key.

Objectives
• Learn about charts, how to create them, and their properties
• Edit the format and layout of existing charts
• Use common mathematical expressions and aggregations in charts
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Auto Minimize and Auto Restore

By default, charts are automatically minimized, or restored when you dou-
ble-click on its header. A minimized chart will appear as a small icon with a 
thumbnail of the type of chart it is. Below is an example of these icons:

Should you ever need to disable the auto minimize functionality of a chart, 
you can do so by un-checking the Allow Minimize and Auto Minimize 
options in the Caption tab of the Chart Properties dialog.
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Changing Chart Type with Fast Type Change Icon

Some charts in QlikView are suited for displaying as more than one type. 
You can select which types by clicking on them in the Fast Type Change 
window on the General tab of the Chart Properties dialog.

When looking at the completed chart, this is shown as a little icon in the 
chart’s header. The icon appears as a miniature of the next chart type that 
will appear if you click on it. 

This example shows us the next chart type will be a Bar 
Chart if we click on the icon

Creating a Chart
The general way to create a chart is to define what the chart should show 
and what it should look like in the Chart Properties dialog. However, if you 
want to create a simple chart and you do not need many detailed settings, 
you may prefer to use the QuickChart Wizard. In both cases you will get a 
full-blown chart, only the creation process is simplified when using the 
QuickChart Wizard.
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Creating a Chart Using the Quick Chart Wizard

Let's start with a chart showing the sales per country.

1 Go to the sheet Basic Objects and choose QuickChart Wizard 
from the Tools menu or click the QuickChart button in the tool-
bar.

The first page of the QuickChart Wizard explains the purpose of the wizard 
and the basic steps to create a chart using the wizard.

2 Click Next.
3 In Step 1 you choose the chart type. The bar chart is selected by default, 

so you just click Next.

Figure 1.  The first page of the QuickChart Wizard
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4 Step 2 is the definition of the chart's dimension, shown on the x-axis. 
Choose Country from the dropdown list First Dimension. Then click 
Next.

5 In step 3 you define the chart's expression used to calculate the bar 
height. Sum is already pre-selected. Choose the field LineSalesAmount 
from the dropdown list.

Figure 2.  Defining the chart's dimension
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6 Step 4 offers you just a couple of often used formatting options. Leave 
the settings unchanged and click Finish.

With the chart on the sheet, it is obvious there is room for improvement 
regarding the chart title, formatting or sorting. Next, adjustments can be 
made in the Chart Properties dialog.

Creating a Chart Using the Full Properties Dialog

Now, let's take the long way and create a new chart showing the number of 
orders per customer using the Chart Properties dialog.

1 Go to the sheet Basic Objects and create a bar chart by choosing New 
Sheet Object - Chart from the Layout menu.

Figure 3.  Defining the chart's expression

Figure 4.  The finished chart showing Sales per Country
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2 Under Chart Type, the bar chart is already pre-selected. Click Next. This 
will take you to the Dimensions page.

3 Specify what the x-axis is representing by selecting a dimension from 
Available Fields/Groups. In this example, we select CompanyName 
and click Add >.

Figure 5.  The first page of the Chart Properties dialog
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4 Under the Label option enter Customer as name for the dimension.
5 To specify what you want the y-axis to represent, click Next. This takes 

you to the Edit Expression dialog.

Figure 6.  The dialog page Dimensions
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6 If you are familiar with the expression syntax, you can type your expres-
sion directly into the expression editor. Otherwise, the options in the 
bottom of the dialog will help you to create the expression. In our case, 
we will build the function count(OrderIDCounter) by selecting Total 
count in the dropdown list Aggregation and OrderIDCounter under 
Field.

7 Click the Paste button, followed by OK, to close the Edit Expression 
dialog. This will bring you back to the Chart Properties: Expressions 
dialog. There, enter Orders as the Label for the expression and check 
Numbers on Data Point under Display Options.

Figure 7.  The Edit Expression dialog

Note: Had the QlikView developer not created the OrderIDCounter field 
in the data model, you might have had an issue with getting accurate 
numbers here. It might have been necessary to check the Distinct option 
to make duplicate order IDs count only once.
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8 There are several additional pages allowing various customizations to 
the chart, but we have entered enough information to create a basic 
chart by clicking Finish to get a fully operational, if somewhat confusing 
chart, shown below:

Selections in Charts
We should take a moment to talk about selecting data directly within a 
chart. Since it is a live object, there are several methods to make selections 
directly in charts:
• Hold down the left mouse button and drag over some of the bars in the 

chart. You have now selected the customers corresponding to the 
selected bars.

• To narrow down the selection, you can drag over one or a few of the 
remaining bars.

• Non-adjacent values can be selected by means of the CTRL-click method.
• Choose Clear All Selections from the chart's object menu to selectively 

remove those selections made in the chart, or click the Clear button to 
remove all selections.

• You can also make multiple selections by dragging over values along the 
x-axis, provided that they are visible.

Changing the Chart Properties for Existing Charts
So, you have created a basic chart but want to improve its appearance? This 
section provides additional examples of what can be accomplished with the 
powerful charting capabilities in QlikView. We will move through a couple 
of examples to improve the look and function of the charts created in the 
previous sections of this chapter.

Figure 8.  The basic Orders per Customer Chart
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Changes to existing charts are made in the Chart Properties dialog which is 
opened by right-clicking the chart and choosing Properties from the menu.

Our first goal will be to simplify the look of the Orders chart created in the 
section, above.

Sorting and Limiting the Dimension Values

To sort and limit the display of the dimension values (the customers dis-
played on the chart and the number of orders they placed) we will perform 
the following steps:

1 Right-click the Orders chart and open its Chart Properties dialog. Go to 
the Sort page.

2 In the Sort by group check Y-value and Descending to sort the bars 
according to their size.

3 Click OK to close the dialog and check the result.

We should also limit the number of customers (i.e. dimension values) dis-
played at one time on the chart:
4 Right-click the chart again and go to the dialog page Presentation. 

Limit the number of bars by checking Max Visible Number and entering 
10 in the edit box.

5 Repeat the same steps for the Sales Per Country chart.

 Displaying and Formatting Numbers in Charts

In the sales chart, it would be nice to have numbers displayed on the bars 
like in the orders chart.

1 Open the Chart Properties: Expressions page of the Sales chart and 
check the option Numbers on Data Point. Click OK to see the result.

Figure 9.  The Orders chart after the first adjustments
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Now there are numbers displayed but obviously, the number format should 
be adjusted for a better overview.
2 Right-click the chart again and go to the Chart Properties: Number 

page.
3 Check Fixed to. This format makes it possible to limit the number of 

decimals shown. Set the Decimals value to 1.
4 Type $ as the unit for the y-axis under Symbol.
5 Type 1000 $ under 1000 Symbol and click OK.

Adjusting the Dimension Labels

The x-axis labels in both charts are a bit squeezed. Apart from a further lim-
itation of the number of bars, there are more things that can be done to 
solve that problem. We will run through some of them now on the Sales 
chart. You are welcome to try them out on one or both charts. You will also 
get experience with this in the exercise at the end of this chapter. The set-
tings may also be combined.
• You can set a smaller font for the x-axis labels. To do this, go to the 

Chart Properties: Axes page. Under Dimension Axis click Font and 
select a smaller font in the Font dialog.

• You can display the labels vertically or diagonally. This is done in the 
Chart Properties: Axes page under Dimension Axis by choosing the 
corresponding symbol for the Primary Dimension Labels. 

• You can limit the number of characters for the dimension labels. This 
makes sense when the differing lengths of the labels cause problems in 
the display. To do this, activate the option Limit Legend (Characters) in 
the Properties: Presentation dialog and enter a maximum number of 
characters in the edit box.

You can hover the mouse pointer over the bars of the chart to get a display 
popup info showing the x-axis and y-axis values (unless the popup labels 
have been deactivated).

 Setting the Chart Title

While the orders chart already has an appropriate chart title, the sales chart 
has not. The title can be set in the General dialog page, primarily used for 
choosing a chart type.

1 Right-click the sales chart and go to the dialog page Chart Properties: 
General.

2 Check Show Title in Chart if this has not already been done.
3 Enter the title Sales Per Country.
4 Click OK.
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Like the following pictures show, the finished charts look much better after 
these basic modifications. We have now covered the most elementary steps 
available for making charts clean and simple.

Other Chart Properties

In addition to those settings and properties that we have already mentioned, 
there are numerous others in the Chart Properties dialog. Some of the more 
important items contained in these pages are listed, below:

General
check boxes for fast type change, calculation conditions and custom 
error messages

Dimensions
a button for chart animation

Figure 10.  The finished charts
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Expressions
options for accumulation and trend lines

Style
a range of different looks to choose from, depending upon the chart type 
you have chosen

Presentation
contains further formatting options, including the ability to add x-axis 
scrollbars, formulaic text and reference lines

Colors
options for colors, transparency and background; set the colors for the 
bars and the chart background

Font
this page applies to all text in the chart, which has not been set to a font 
of its own in separate font controls (e.g. for axes). 

Layout
holds the same options as for list boxes

Caption
holds the same options as for list boxes

Feel free to experiment with these settings and refer to the QlikView Refer-
ence Manual or online Help file for details.

Common Chart Types
So far, we have only worked with bar charts. QlikView provides a whole 
range of other chart types. In this section we will present a gallery of some 
of the types.

Pie Chart

To transform the Sales bar chart from the previous section into a pie chart, 
you simply:

1 Right-click the chart again and go to the dialog page Chart Properties: 
General.

2 Click the pie chart symbol.
3 Continue to the dialog page Presentation.
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4 Check Show Numbers in Legend to have the values displayed in a leg-
end inside the chart.

5 Click the OK button.

In the same manner, you can turn your chart into most of the other available 
chart types. You should of course consider which chart type is best suited to 
the particular situation. 

Block Chart

We continue by transforming the pie chart into a block chart, in which the 
block area shows the relative size of each value:

1 Right-click the chart again and go to the dialog page Chart Properties: 
General.

2 Click the block chart symbol.
3 Click the OK button.

Figure 11.  The Sales chart, transformed into a pie chart
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Straight table

When the program draws a graphical chart representation, the chart is actu-
ally based on an underlying table. The table can be displayed by transform-
ing the chart itself. This is accomplished as follows:

1 Reopen the Chart Properties: General page.
2 Click the Straight Table symbol.
3 Click the OK button and adjust the columns as necessary.

Figure 12.  The Sales chart transformed into a block chart (try to determine what 
else was changed to produce this block chart view of the data)
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A Note About Mathematical Expressions
In the Edit Expression dialog, you can choose from the list of aggregation 
functions. We have been using the functions Sum and Total Count so far, but 
there are further functions to choose from. When you have picked a func-
tion, select the field whose values should be used for the calculation and 
click Paste to transfer your new expression into the Expression window. 

If you should make a mistake, you can edit or delete the expression directly 
in this window. The Edit Expression dialog also keeps track of what you 
type, it offers Undo and Redo commands in its Edit menu and warns you 
with color or error messages if you use bad syntax or illegal fields in expres-
sions.

Figure 13.  The Sales chart, transformed as a straight table
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Some of the most commonly used functions are mentioned below. The 
QlikView Reference Manual and the Help provide complete descriptions of 
all aggregation functions.

Numeric count The number of numeric values

Total count The total number of values

Sum The sum of possible numeric values

Average The average of selected numeric values

Min The smallest of the selected numeric values

Max The largest of the selected numeric values

Only value If there is only one value, this is shown

Figure 14.  Choice of aggregation functions in the Edit Expression dialog
124



QlikView Designer I | CHARTS
Generally, it is not possible to use more than one aggregation function on a 
field name (like a sum of averages of field values). In case you want to calcu-
late such nested aggregations you will need a more complex syntax. Again, 
please refer to the QlikView documentation for more information on not 
only aggregation functions, but the entire library of functions available for 
use in calculations and expressions, or you can attend additional QlikView 
training.

Exporting charts
There are many ways to export QlikView charts or chart data to files or 
other programs. All necessary commands are found in the chart's menu, 
opened by right-clicking the chart. The commands vary slightly depending 
on whether it is a graphical chart (like bar, line, pie or block chart) or a table 
chart (straight table or pivot table) but the functionality is similar.

Print as PDF
Exports (prints) the chart to a PDF file. Visit Qlikview.com to download 
the QlikViewPDF printer driver, once installed, it can be selected from 
the Printer Name dropdown list when printing to a conventional printer

Send Values to Excel
for graphical charts

Send to Excel
for table charts
Exports the table chart or the data behind the graphical chart to Excel.

Export
Saves the chart to a file. For graphical charts you can choose between 
jpg, bmp, png or gif format. For table charts, QlikView offers even more 
formats, including several text formats, html, xml or xls.

Copy  to Clipboard
• Full Table - Table charts only
• Table Data Area - Table charts only
• Cell Value - Table charts only
• Values - Other charts only
• Image

Tip: Remember that functions and calculations can be used in text objects, and 
also anywhere you see the Ellipsis button  in QlikView.
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• Object

References in charts
In many cases, it is useful to compare chart data for different selections. For 
this purpose, you can use chart references.

1 On the Sample sheet, look at the bar chart Sales per Country. Clear all 
selections in case there are any.

2 Select Men's Footwear in the Category list box.
3 Right-click the bar chart Sales per Country and choose Set Reference 

from the menu. Now dimmed reference bars are displayed.
4 Select Women's Footwear in the Category list box. The current bars 

show the sales for women's footwear while the reference bars still show 
the sales for the previously selected men's footwear and you can easily 
compare the values.

5 Right-click the chart again and choose Clear Reference from the menu.

Figure 15.  Set Reference
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EXERCISE – CHART BASICS

Do:
1 Navigate to the c:\QlikViewTraining\DesignerI\Chapter9 directory and 

open the QVDesigner1_Chapter9.qvw file, or, if you are doing all the 
exercises in a linear progression, open the QVDesigner1_Student.qvw 
file and continue to use it in subsequent chapters. This file is located in 
the c:\QlikViewTraining\DesignerI\ directory. Course files and data will 
still be accessed in the chapter directories.

2 Save a copy of the file to preserve the original in case you want to start 
again from the beginning later. Do this by using the File | Save As com-
mand. There is also a QlikView file ending in “_Solution.qvw” contain-
ing the completed exercise for your reference.

3 Create a bar chart showing the sales per product category on the Charts 
sheet. You may use the QuickChart Wizard or the full Chart Properties 
dialog. Your chart should have the following properties: 
• CategoryName as x-axis dimension
• Label the dimension CategoryName as Category
• Sum(LineSalesAmount) as y-axis expression
• Sales Per Product Category as chart title
• The bars should be sorted by height, starting with the highest
• There should be numbers indicating the y-values on the bars
• The sales should be shown by 1000 $ 
• The dimension labels should be displayed diagonally 
• The chart should have multi-colored bars, but, in rare cases such as 

this one where multi-colored is selected, be sure to also check the 
Persistent Colors box (Chart Properties: Colors page).

Figure 1.  The completed chart
127





QlikView Designer I | EXERCISE
EXERCISE – OPTIONAL ADDITIONAL CHARTING

Do:
1 Continuing with the chart from the exercise, in the Chart Properties: 

Style page, change the chart's orientation to display horizontal bars.

2 Click on the Chart Properties: Caption page. It holds several settings for 
the chart's caption. Under Special Icons check Print and Send to Excel. 
Close all dialogs by clicking OK and test the new icons in the chart’s cap-
tion.

3 Create a pie chart showing the number of delivered orders per shipper. 
Your chart should have the following properties:
• Shipper as dimension
• Count(OrderIDCounter) as expression (either typed by hand or 

pasted in using the function wizard, in which case, the aggregation to 
select is “Total Count”)

• Shippers as chart title
• The slices should be sorted by y-value
• There should not be numbers in the legend

4 You can check the Relative option in the Chart Properties: Expressions 
page to show percentages instead of absolute numbers.

Figure 2.  The chart from the previous exercise, with modifications 
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5 Modify the properties of this chart to allow users to change it from a Pie 
Chart to a Straight Table using the Fast Type Change check boxes in 
the General page. Be sure to check both types (you will need to scroll 
down to find the Straight Table check box).

Here is how the completed chart would look when the Fast Type Change is 
used to convert it to a Straight Table:

Figure 3.  The completed pie chart
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10 THE QLIKVIEW SCRIPT: BASIC

QlikView layout design training is intended for designers who work mainly 
with existing QlikView applications. This chapter provides an overview over 
the process of loading data into a QlikView application and explains about 
basic concepts and procedures. You will also get an opportunity to load data 
into your QlikView file from an Excel spreadsheet.

This course does not cover scripting best practices or script management. 
These topics are covered in the QlikView Developer course offerings. 

Loading Data into QlikView
So far, we have been working with QlikView files that have already been 
loaded with the data needed to complete the exercises in the chapters. In this 
chapter, we will concentrate on how data is actually loaded into QlikView. 

A QlikView document is created by retrieving data from one or several 
sources, e.g. from a relational database or from text files containing data 
tables. This retrieval is done by writing and executing a load script, in which 
the data source, the tables and the fields to be loaded are specified. In addi-
tion, the script offers possibilities to modify the data while loading. Simple 
scripts can be generated automatically with the tools included in QlikView. 

When executing the script, the loaded data is kept in an internal data repos-
itory which is saved with the QlikView document. An evaluation of this 
data repository is made each time a value is selected in the document’s lay-
out. The figure below outlines how the different parts are related:

Objectives
• Introduce the QlikView load script
• Load data from Microsoft Excel
• Explore the structure of the data model in QlikView
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What data can QlikView read?
QlikView can handle the following types of data sources:
• Any type of character separated text files, e.g. comma separated files
• The result of a database query, made by SQL via OLE-DB/ODBC
• Previously created QlikView files (binary files); used to populate the data 

in your QVDesigner1_Chapter10.qvw file 
• QlikView QVD files
• Excel files in standard BIFF code
• Fixed format files
• DIF files
• HTML tables
• XML tables

With QlikView Desktop, a connection can be made to a data source residing 
locally or on a server. You can also connect via the Internet.

Finally, it is possible to include text files directly in the script and also to 
type in (preferably short) tables.

Figure 1.  Loading and storing data from external sources in a QlikView document
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Structure of the Data Repository
The data loaded by the script are stored in the document's data repository 
and saved with the .qvw file. You can see its structure using the Table 
Viewer which is opened from the File menu. This was discussed previously 
when we created a text object containing an image of the data structure 
taken from the table viewer. If you have completed that exercise, you will 
already have seen this image. If not, it is repeated, below.

Figure 2.  The Table Viewer shows the internal data structure of the QlikView doc-
ument used in the QlikView Designer I course
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The internal data structure consists of several tables. These are linked to 
each other via the key fields, i.e. fields with the same name occurring in 
more than one table.

The links between tables are used for logical connections. For example, 
when you select a customer, the respective data set in the Customers table 
will be logically connected with data from the Orders table having exactly 
the same value (in this case: customer name) in the key field CustomerID. 
Thus, logical connections propagate from one table to another via the key 
fields with every selection.

The Edit Script Dialog
The data in our training document QVDesigner1_Chapter10.qvw comes 
from the QlikView file used in the QlikView Developer class. That file is 
located in a subfolder called DataSources.

Now it's time to have a look at the load script. Click the Edit Script button 
in the toolbar to open the Edit Script dialog.

Figure 3.  The Edit Script dialog – A: Menu Buttons, B: Script area, C: State-
ments pane, D: Tool pane
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The dialog has a menu, a toolbar and several controls and settings. Again, 
the Developer class goes into greater detail than we will here.

The large pane in the center shows the syntax of the current script. It starts 
with the Binary statement, loading data from another Qlikview file, and is 
followed by  SET statements defining general number, date and time for-
mats. Whether you type the script directly or use the wizards to create it a 
range of load statements are used to read the data from the data source. 
Please have a look at the following load statement:

You can read this syntax as follows:
• Specification of the table name to be used in the internal database, fol-

lowed by a colon, in this case, it is Orders
• LOAD statement, followed by a list of fields to be loaded, followed by 

the 
• FROM clause defining from which file the data should be read and which 

formats are used.

The load statement in the example for the Orders table uses date functions 
on the field OrderDate to generate the fields Day, Month and Year. 
QlikView offers a large number of script functions, which you can look up 
in the QlikView Reference Manual or in the Help if necessary.
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Don't worry too much if you don't understand the entire script in detail. 
You will get a chance to use the script editor in the exercise for this chapter 
when you load data into QlikView from an Excel file.

Executing the script
The easiest way to update the data in a QlikView application is to perform a 
reload. You can use the Reload button to execute the existing script. This 
will update the QlikView document from its data sources. Whenever the 
data sources have been modified you should update your QlikView applica-
tion by performing a reload.

Applications deployed in an enterprise environment are usually updated via 
a scheduled process, managed in conjunction with QlikView Server and 
QlikView Publisher. The application manager may deny users the privilege 
to perform updates.

Loading files with the Table File Wizard
Let's see how data from an additional Excel file can be loaded. We are going 
to assume you are a Human Resources manager and have just obtained 
some information about your employee performance evaluations and raises 
and would like to bring that into your QlikView file without having to 
request an update from the (HRIS) Human Resources Information System. 
This will allow you to do some quick calculations.
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EXERCISE: LOADING FILES WITH THE TABLE FILE 
WIZARD

Do:
1 Navigate to the c:\QlikViewTraining\DesignerI\Chapter10 directory and 

open the QVDesigner1_Chapter10.qvw file, or, if you are doing all the 
exercises in a linear progression, open the QVDesigner1_Student.qvw 
file and continue to use it in subsequent chapters. This file is located in 
the c:\QlikViewTraining\DesignerI\ directory. Course files and data will 
still be accessed in the chapter directories.

2 Open the file Reviews_Raises.xls in the Datasources folder for this chap-
ter and have a look at its content in Excel.

3 Go back to QlikView and open the Edit Script dialog.
4 Scroll down and position your cursor at the very end of the script.
5 Type Reviews_Raises: (Please don't forget the colon!).
6 In the bottom under Data from Files, make sure that the option Relative 

Paths is checked, and click the Table Files button.
7 Search for the file Reviews_Raises.xls and click Open.

You have now opened the Excel file in the Table File Wizard.

Figure 1.  The Table File Wizard analyzes the file and generates the load 
statement
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When opening a table file, the program tries to interpret the contents 
and formats of the file. This interpretation is reflected in the parameters 
in the upper half of the dialog. The lower half contains a preview pane 
where you can check whether this interpretation is correct.

Usually, QlikView recognizes table file formats very well and you don't 
need to do anything more. Nevertheless, if you notice that the table is 
not interpreted properly, you can change the initial values manually.

In our case, the preview looks correct. The field names are found in the 
first line. The columns contain the respective data. 

To avoid problems with the data already in our QlikView file, we will 
delete the Name column before loading the file.

8 Click on the green X at the top of the Name column to remove it

9  Click Finish.
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You are now back in the Edit Script dialog and the wizard has generated 
a load statement for the Reviews_Raises table file. Furthermore, there is 
a directory statement, which you can ignore (or even delete, if you like). 
You may also notice that there are square brackets around field names 
when these contain spaces.

10 Click the Reload button in the Edit Script dialog to execute the script 
and to load the data.

11 The Sheet Properties: Fields page is opened and when you scroll down 
the field list you will find the new fields from the Reviews_Raises table. 
These fields can now be used in sheet objects

12 Close the dialog.
13 Choose Table Viewer from the File menu and see how the 

Reviews_Raises table has been integrated in the internal database.
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QlikView automatically sets up an association between the 
Reviews_Raises and the Employees tables because both contain the key 
field EmployeeID. 

Whenever you plan to load a table into your document you should think 
of what data it holds, what existing table it could or should be associ-
ated with and what field would be suitable to be used as a key field.

Two tables should not have more than one field in common, otherwise 
the values of the key fields will be combined in a composite (synthetic) 
key which requires a separate table and may slow down the performance 
of the application. 

Renaming Fields while Loading
You have learned by now that two tables are associated via the field they 
have in common. The criteria for two fields to be associated is that they 

Figure 2.  The Reviews_Raises table in the internal database
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have exactly the same name. However, in real life, fields that should be asso-
ciated do not always have the same name in their data sources. Therefore, 
the renaming of fields during the load process is a common procedure when 
building the QlikView data structure. You may also rename fields to prevent 
associations that would not be appropriate.
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EXERCISE: RENAMING FIELDS WHILE LOADING

Do: 
There is another Excel file to load in the DataSources folder: 
Retirement_Accounts.xls.

1 Open the file Retirement_Accounts.xls in the DataSources folder and 
have a look at its content.

Do you have an idea of how the Retirement_Accounts table could fit in the 
existing data structure? 

The Employees table holds a field called EmployeeID containing numbers 
identifying employees in the HRIS system. This field can be used as a key 
field to associate the new Retirement_Accounts table. But in the 
Retirement_Accounts table this field is called EmpID instead of Employ-
eeID. To achieve the proper association, we will rename the field EmpID to 
EmployeeID when loading the Retirement_Accounts table.
2 Go back to QlikView and open the Edit Script dialog.
3 Scroll down and position your cursor at the very end of the script.
4 Type Retirement_Accounts: (Please don't forget the colon!).
5 In the bottom under Data from Files click the Table Files button.
6 Search for the file Retirement_Accounts.xls and click Open.
7 Make sure that the Table File Wizard interprets the table structure prop-

erly.
8 In the preview pane, click the header of the first column. You are now in 

the edit mode. Change the name from EmpID to EmployeeID and press 
Enter.

9 Click Finish and have a look at how the renaming is coded in the load 
statement in the Edit Script dialog.

Figure 3.  Renaming a field in the Table Files Wizard
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10 Click the Reload button in the Edit Script dialog to execute the script 
which loads the data.

11 The Sheet Properties: Fields page is opened and when you scroll down 
the field list you will find the new fields from the Retirement_Accounts 
table. These fields can now be used in sheet objects

12 Close the dialog.
13 Open the Table Viewer and make sure that the association has been 

established as expected.

Just in case something went wrong or you notice that the association is not 
adequate, you can edit the script syntax directly in the Edit Script dialog 
without passing through the Table File Wizard again. You may remove the 
as to undo the renaming or you may enter an as for another field in the field 
list of the load statement. Do not forget to perform a reload after changing 
the script. Your changes will only take effect when the script is executed.
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11 THE SETTINGS MENU

All of the material in this chapter can be found in the online Help or the Ref-
erence Manual. The following information is provided for reference as you 
work to complete the course exercises. 

Obviously, for fully detailed information, please refer to the online Help and 
the Reference manual.

User Preferences
From the User Preferences dialog you can set your personal preferences for 
the way QlikView behaves on your computer. 

Choose User Preferences under the Settings menu. 

User Preferences: General 

The General page contains several very useful options. Most of these are 
self-explanatory. We would like to highlight one useful setting.

Objectives 
• Define useful user preferences and options
• Save copies of your work automatically
• Learn about memory resources, exporting and printing, security
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Include Excluded Values in Search
When this option is checked, free text searches will include every value 
in a field, also those that are currently excluded by selections in other 
fields.

User Preferences: Save

The Save page is used for managing automatic backup routines. During the 
process of building a QlikView application, it is a good idea to turn these 
options on to enable you to recover from development mishaps or mistakes. 
Obviously, the more of these options you set, the more disk/file space you 
will use.

Figure 1.  The dialog page User Preferences: General
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User Preferences: Editor

The Editor page is used for making font related settings that are used in the 
script editor, the expression editor and in the macro editor.

User Preferences: Design

The Design page contains several advanced features related to the macro 
functionality and to the general design.

User Preferences: Objects

In the Objects page you can determine how the memory resources are allo-
cated in QlikView.

Some useful settings are:

Figure 2.  The dialog page User Preferences: Objects
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Enable all confirmation messages
When you remove a sheet or sheet object you are by default asked to 
confirm the action. In case you deactivated these warnings, you can click 
on this button to enable them again.

Click in Chart Background Clears Selection
With this setting on you can clear selections directly in charts by clicking 
in the chart background.

User Preferences: Font

Use the Font page to set the Font, Font Style and Size of the font to be used.

User Preferences: Export

The Export page is used for modifying the number format and layout of 
data that is exported from QlikView. There are numerous settings. For the 
purposes of this course, they are considered self-explanatory.

User Preferences: Printing

The Printing page takes care of a few default layout settings for printout.

User Preferences: Mail

The Mail page contains settings for sending e-mail from QlikView, such as 
would be required to activate alerts. To use this functionality you must have 
access to an SMTP server.

User Preferences: Locations

The Locations page is used for determining default folder locations for cer-
tain files created when working with QlikView and was reviewed previously 
in relation to setting the location of the QlikView Theme (qvt) files. 

It also shows the options for configuring the locations for QlikView Server 
and Publisher. These are covered in a separate course.

User Preferences: Security

The Security page gives you the ability to override some of the security fea-
tures set by default. These are rarely changed here. Security is covered in the 
Developer class. Do not change the settings unless you know what you are 
doing!

User Preferences: License

The License page is primarily used if you ever need to edit your license 
number for the QlikView copy installed on your computer. QlikTech Sup-
port can assist you with problems relating to license key validation where 
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your corporate firewall might be blocking access to the QlikView license 
server.

Document Properties
In the Document Properties dialog you can set preferences that are specific 
to the current QlikView document (qvw file).

Choose Document Properties from the Settings menu. There are 15 dialog 
pages, but we will only deal with the most important ones here.

Document Properties: General

The most important options are:

Title
This is where you name the document. The title will be visible in the 
QlikView title bar.

Note: Do not click Unregister unless you are really determined to unreg-
ister the licensing information. Unregistration occurs immediately, with-
out any further warning.

Figure 3.  The dialog page Document Properties: General
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Default Sheet Background
A handy way to change the layout for the default sheet background. You 
may either choose a Background Color or a Wallpaper Image.

Save Format  - Compression None/Medium/High
The high compression rate makes the file much smaller, while costing a 
little more in terms of performance.

QlikView files are actually quite compact to begin with, but once in a while 
you may need to save a file in extra compact format. With the high compres-
sion setting, a qvw file will typically be reduced by 85%. This will slightly 
increase the time it takes to open the file.

Document Properties: Opening

The Opening page makes it possible to select a picture to be displayed and/
or a sound file to be played when the document is opened. It also contains 
more advanced functionality.

Document Properties: Sheets

The Sheets page can be used for keeping track of all sheets and sheet 
objects in the document. 

Document Properties: Server

The Server page is used to define certain aspects of the QlikView docu-
ment’s behavior when run on a QlikView Server. Some of the details sur-
rounding the refresh mode are covered in a different class. Similarly, server 
bookmarks, objects and reports are covered in other QlikView training 
courses. In summary, with:
• Server Bookmarks – remote clients can create and share bookmarks 

with this document on the QlikView Server.
• Server Objects –  remote clients can create and share sheet objects with 

this document on the QlikView Server.
• Server Reports –  remote clients can create and share reports with this 

document on the QlikView Server.

Note: Sometimes a sheet object is inaccessible from the sheet layout 
because it is hidden beneath another object, it has ended up outside the 
visible part of the window or it has a show condition. Here it is easy to 
find an object in the list and then enter by the "back door" into its prop-
erty dialog by means of the Properties… button.
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Document Properties: Variables

The Variables page is intended for the handling of variables. A variable is 
often a value that changes, such as an exchange rate from $ to €, which can 
be updated with user input, or based upon a user selection. 

Document Properties: Security

In the Security page you may specify certain limitations to the User Privi-
leges. The reasons to do this could be that you want to protect the layout of 
the document from harm or that you want to hide sensitive data. Users with 
User privileges cannot open the security dialog pages for the document or 
the sheet. The privileges are set in the script. Privileges and security are 
advanced properties that are not covered by this course. (Note that because 
nothing is stated in the access restrictions database, you are automatically 
granted administrator privileges in this document.)

Figure 4.  Server Page, Document Properties
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Document Properties: Triggers

The Triggers page is used in some advanced applications and is not covered 
by this course.

Document Properties: Groups

The Groups page is used for creating field groups. Groups can be used for 
increasing the information density in a chart. By specifying a group rather 
than a field, you can let the chart switch between dimensions along the x-
axis.

Open the Document Properties: Groups dialog in your course file and you 
will find that a group is already defined. It can be found in the left column. 
If you click it, you can see what fields have been used for defining it.

A group may be set to either drill-down or cyclic display, as indicated by 
small symbols to the left of each group:

Drill-down
With this setting, the level of detail will gradually increase when you 
make your selections in the group. You can recognize a drill-down group 
by the small icon  that is shown next to the group name. You can 
click the icon to drill back upwards through the hierarchy. This symbol 
is also displayed in a chart containing a drill-down group.

Figure 5.  The dialog page Document Properties: Groups.
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Cyclic
With this setting  you may select which of the fields of the group will 
be displayed. You can switch between fields just by clicking the small 
icon next to the field name.

Document Properties: Tables

The Tables page is used for advanced script management and is not covered 
by this course.

Document Properties: Sort

This is where you determine default sort order settings to the fields of the 
current document. These settings are applied when new sheet objects are 
created.

Document Properties: Presentation

This is where you determine default adjustment settings to the fields of the 
current document. These settings are applied when new sheet objects are 
created.

Document Properties: Number

This is where you determine default number formatting settings to the fields 
of the current document. These settings are applied when new sheet objects 
are created.

Document Properties: Scrambling

The Scrambling is only available when working with a QlikView document 
in ADMIN mode. With it, you can scramble the data in one or more fields 
to quickly render their contents anonymous. This can be particularly useful 
with sensitive information.

Note: Numbers are scrambled to numbers and text to text (spaces are 
kept). Once scrambled, the data cannot be recreated in its original form 
by QlikTech or anyone else. If you re-execute the script, however, the 
scrambling will be lost.
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Document Properties: Font

This is the general font dialog, which is used for determining default font 
settings to the sheet objects of the current document.

Document Properties: Layout

This is the general layout dialog, which is used for determining default lay-
out settings to the sheet objects of the current document.

Sheet Properties
In the Sheet Properties dialog you can set preferences that are specific for a 
certain sheet of the QlikView document. Any changes that are made will 
only affect the objects of the current sheet. Some of the dialog pages have an 
option Apply to All sheets, though.

To open the dialog, choose Sheet Properties in the Settings menu or right-
click the sheet and choose Properties from the menu. 

There are 7 dialog pages.

Sheet Properties: General

Here you can specify a Title and Wallpaper for the current sheet. This is also 
where you can reach the tab color settings. 

One important setting is Show Sheet, where a show condition can be 
entered.

Sheet Properties - Fields

This is the same dialog page that is opened when you use the menu com-
mand Layout – Select fields for adding list boxes to the sheet.

Figure 6.  The Scrambling Page
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Sheet Properties: Objects

The Sheet Properties: Objects page helps you keep track of all sheet 
objects residing on the current sheet.

Sheet Properties: Security

This dialog page is similar to the Document Properties: Security dialog 
page, but it contains security settings on the object level. This is the most 
convenient place for you to protect the layout with all its sheet objects from 
accidental corruption. 

Sheet Properties: Triggers

The dialog page Sheet Properties: Triggers is used for creating macros that 
are triggered by sheet events and sheet object events. As previously stated, 
macro functionality is not covered by this course.

Inherited settings
Many of the settings described above may be defined for a single sheet 
object in the Object Properties dialog, for all objects on the current sheet in 
the Sheet Properties dialog or for all objects in a document in the Docu-
ment Properties dialog.

In these cases, QlikView works according to the principle of hierarchical 
heritage. A setting made on a higher level (e.g. in Document Properties or 
Sheet Properties) will propagate downwards to lower levels (e.g. List Box 
Properties).

Settings with Immediate Propagation

An inherited setting with immediate propagation will affect all objects on a 
lower level as soon as it is executed. An example of such a setting is Font. If 
the font is changed under Document Properties, the font will immediately 
change in all sheet objects in the entire application. The same is true for set-
tings in the Layout page.

Note: If you cannot see a sheet object in the layout, it can still be reached 
from this dialog.

Note: Be aware that the option Admin Override Security in the Docu-
ment Properties: Security dialog page overrides all security settings of 
the sheet.
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Settings with Default for New Objects

In other cases, changing a setting on a higher level will only establish a new 
default to be used when new sheet objects are created. If you change Align-
ment for a field under Document Properties, nothing will happen until you 
create a new sheet object using that field. Existing sheet objects based on the 
same field will not be affected.

In the same token, if adjustments are made to the Layout or Font settings for 
a single sheet object, these settings will continue to be applied when new 
objects are created in the document.
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Exercises

Do:
1 Navigate to the c:\QlikViewTraining\DesignerI\Chapter11 directory and 

open the QVDesigner1_Chapter11.qvw file, or, if you are doing all the 
exercises in a linear progression, open the QVDesigner1_Student.qvw 
file and continue to use it in subsequent chapters. This file is located in 
the c:\QlikViewTraining\DesignerI\ directory. Course files and data will 
still be accessed in the chapter directories.

2 Earlier in the course we configured our QlikView environment for auto-
matic backups. Confirm those settings here. In the User Preferences, 
check the settings on the Save page to provide (“Use”) backup copies of 
your QlikView application

3 Also in User Preferences, Enable all confirmation messages on the 
Objects page

4 Confirm the file locations in the User Preferences: Locations page.
5 Give your QlikView document a meaningful title using the Document 

Properties: General page. Also, add yourself as the primary Author. 

Change or remove the Default Sheet Background Wallpaper Image.
6 Experiment with hiding the tabrow.
7 Check the General Logfile checkbox. This will create a logfile every time 

you reload the data into the QlikView file.
8 On the Document Properties: Opening page, select an image or sound 

file or both to use as a splash screen whenever your QlikView document 
is opened.
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12 APPENDIX — REFERENCE MATERIALS

QlikView Version 9.00 Clients

AJAX Clients
The AJAX client now has full support for all types of user objects and 
shared objects. The new user sheets are also supported. 

Additional layout features previously not supported in the AJAX client have 
been added in QlikView 9.00, such as support for:
• On Open message alerts
• Gauges in table cells
• Images in list boxes
• Semantic list boxes
• x-axis scroll in charts
• Balloon pop-ups in charts
• Right-click menu on cycle icons
• Right-click menu on fast type change icons
• Free-floating current selections window
• Bookmark toolbar
• Maximization of sheet objects
• Automatic truncation of text in cells (as in installed client)

In addition to the above new layout features from QlikView 9.00 have been 
implemented also in the AJAX client.

Many of these capabilities are covered in the QlikView Designer II course.

QlikView Java Clients

The Java client now has full support for user objects and shared objects. 
Property dialogs are available for modification of objects as well as undo/
redo commands and design grid. The new user sheets are also supported. 

Additional layout features previously not supported in the Java client have 
been added, such as support for gauges in table cells and images in list 
boxes. In addition, new layout features from QlikView 9.00 have been 
implemented also in the Java client. This includes the spark lines in tables, 
button actions, tree-view list boxes and clickable URL links in table charts.

Objectives
• Highlight updates to QlikView clients
• Share a list of suggested further reading on design and data best prac-

tices
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Mobile Clients
With QlikView 9.00, for the first time it will be possible to bring along the 
power of QlikView analysis on mobile phones. Mobile clients include 
iPhone, JavaMobile client, AJAX on Mobiles.

Suggested Reading - Design and Data
In addition to the built in Online Help and Reference Manuals that are part 
of any complete QlikView installation, the following generally available 
books are excellent tools for expanding your library of information about 
business intelligence tools and projects, in general, regardless of your 
QlikView knowledge or experience. 

Blastland, Michael and Andrew Dilnot. The Numbers Game: The Com-
monsense Guide to Understanding Numbers in the News, In Pol-
itics and In Life. New York: Gotham Books, 2009. 

Few, Stephen. Information Dashboard Design: The Effective Visual 
Communication of Data. Sabastopol, California: O’Reilly 
Media. 2006.

Show Me the Numbers: Designing Tables and Graphs to Enlighten. 
Oakland, California: Analytics Press. 2004.

Norman, Donald A. Design of Everyday Things, The. New York: Basic 
Books. 2002. (reprinted from the original, entitled, The Psychol-
ogy of Everyday Things.)

Norman, Donald A. Emotional Design: Why we Love (or Hate) Every-
day Things. New York: Basic Books. 2004.

Tufte, Edward R. Beautiful Evidence. Cheshire, Connecticut: Graphics 
Press. 2006

Visual Display of Quantitative Information, Second Edition. Cheshire, 
Connecticut: Graphics Press. 2001.

Ware, Colin. Visual Thinking for Design. Morgan Kaufmann, 2008.
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